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INTRODUCTION 

The Internet has progressed at amazing speed in recent years. Once 

the realm of academics and defense agencies, Internet is rapidly becoming a 

mainstream media conduit for communication between individuals. 

As part of the Internet, Worldwide Web is now the predominant force in 

growth. Its language is simple, its interface is attractive and friendly, and it is 

adaptable to a wide variety of uses. 

There are now web sites for selling products, selling ideas maintaining, 

appearances, informing public, continuting education and knowledge, and just 

plain wasting time. And in a growing trend, the Internet concept is being 

adapted to international communication by establishing Internets inside the 

company. 

Normally man has to roam about here and there to get information to 

make investigation and to collect data but nowa days, it is preferable to sit in 

your home just browse the web and get yours desired information . 

The web site designed by me copes with all challenges and it is 

designed in such away that its fulfills the requirements of the age. The web 

site of Punjab and province provide reliable and satisfactory approach to get 

each and every information about Punjab and Sindh . Different topics, which 

are included in this web site, will certainly fulfill the knowledge requirements of 

all people. 



I 

INTRODUCTION OF PAKISTAN 

The Islamic Republic of Pakistan came into being as an independent state on 14 

north-eastern border with China. Iran makes up the country's south-west border, and 

Afghanistan runs along its western and northern edge. The Arabian Sea is Pakistan's 

southern boundary with 1,064 km of coastline. The country has a total area of 803,940 sq 

km with a land area of 778,720 sq km and is nearly four times the size of the United 

I Kingdom. From Gwadar Bay in it's south-eastern corner, the country extends more than 

11,800 km to the Khunjerab Pass on China's border. Pakistan comprises four provinces -
I 
1 Punjab, Sindh, North West Frontier and Balochistan - and the Federally Administrated 

! Tribal Area. The country presents a variety of landscapes . The north to north-western 
I 
mountainous belt is largely a barren region that features many of the world's tallest peaks. 

Climatically, Pakistan is mainly dry with rainfall varying between four to forty inches a year. 

I Temperature varies from extreme summer heat in some places, to a brisk, invigorating cold 

I in winter with heavy snowfall at elevations. Islamabad, with an area of 906.5 kms, is the 

! capital of Pakistan and is situated at the foot of Murree Hills, forms the north-east part of 

I the Potwars Plateau. Islamabad enjoys a pleasant cl imate. The maximum average in winter 

I is 16.7 DC, and minimum 3.4 DC; in summer it is 34.2 DC, and 24.4 DC. The Aiwan-e-Sadr 

(Presidency), Parliment Building, Secretariat Blocks, State Bank Complex, Rawal Lake and 

Faisal Mosque are some of the Capital's land marks. Pakistan embarked upon a modest 

; programme to make a major breakthrough in various fields of cimmunication. It is going 

I ahead with its plans and programmes of modernisation and advancement in this essential 

sector. Thousands of kilometer of new highways and roads are being constructed to cover 

most parts of the country. Telecommunication networks are being improved and expanded 

I to facilitate round-the-clock service. A new and most modern airport has already been bui lt 

! at Karachi, while more are being designed. New methods and policies are being adopted to 

I improve public transport facilities. For improving the railway system, private sector has 

: been involved in selling tickets and checking on some of its sections. A programme is being 

I undertaken for modernizing the existing seaport and building an additional deep waters 

I port. In the air transport sector, 13 private parties have been approved to operate airlines. 
I 

1 The present literacy rate is estimated at 35 percent which shows SUbstantial improvement 

lover 26.2 percent in 1981. The population of Pakistan nearly doubled over a half century 
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I period. The current growth rate of 3.0 percent is the highest among the nine most populous 

countries. Pakistan's conventional energy resources are inadequate to meet generating its 

ever-increasing power needs. The country is largely dependent on hydro-electricity for 

which the installed capacity at present is 10598 MW. However, the low river flows in winter 

I cause a substantial decline in the generating capacity of the hydro-electric plants. The 

: country has to look for other sources of energy such as gas, oil and nuclear energy. 

PROVINCES OF PAKISTAN 

Pakistan displays some of Asia's most magnificent landscapes as it stretches from the 

Arabian Sea, its southern border, to some of the world's most spectacular mountain ranges in the 

north. Pakistan is also home to sites that date back to word's earliest settlements rivaling those of 

ancient Egypt and Mesopotamia For administrative purposes, Pakistan is divided into four provinces 

(Baluchistan, North-West Frontier Province, Punjab, and Sindh); the Federal Capital Territory, 

which consists of the capital city ofIslamabad; and six federally administered tribal areas. 

PUNJAB 
The Punjab plain comprises mainly the province of Punjab. It is the gift of River Indus and its 

five eastern tributaries- lhelum, Chenab, Ravi, Sutlej and Beas. The plain spreads from the south of 

Potohar plateau up to Mithankot, where Suleiman Range approaches river Indus. The Punjab plain is 

almost a featureless plain with a gentle slope southward averaging one foot to the mile. The only 

break in the alluvial monotony is the litt le group of broken hills(100 ft-I,600ft .) near Sangla and 

Irana on either side of the Chenab. The entire plain is extensively irrigated by a network of canals. 

This system has been greatly expanded and improved in recent years by the construction of link­

canals, dams and barrages as a result of the Indus Water Treaty with India, which awarded the three 

western rivers (Indus, lhelum and Chenab) to Pakistan, and the three eastern rivers (Ravi,Sutlej and 

Beas) to India. Tarbela Dam on river Indus and Mangla Dam on River lhelum, which have water 

storage capacities of 11 .1 million acre ft. and 5.55 million acre ft. respectively, need a special 
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mention. Irrigation water is supplemented by summer and winter rains(l5-20 inches) so that a variety 

of crops is raised, the major one being wheat, rice, cotton and sugarcane. The region has earned the 

name of granary of Pakistan. However, the blessings of canal irrigation have not been without a 

curse, which render about 100,000 acres ofland unproductive every year through water-logging and 

salinity. The menace has been greatly controlled through salinity control and reclamation projects. 

Agricultural development boosted urbanization and industrialization so that the region has emerged 

as the most important economically developed area of Pakistan, containing over 56 per cent of the 

population and most of the commercial and industrial centres of the country, such as Lahore 

(2,922,000), Faisalabad (1 ,092.000). Multan (730,000), Gujranwala (596,000), Sialkot (297,000) and 

Gujrat (154,000). The south eastern section of the region known as Cholistan is under-developed. 

This tract is parched and thirsty. The summer temperature average 51.70C and the area remains 

under the grip of extremely hot winds. The surface of this desert consists of a succession of sand 

dunes rising in places to a height of 500 ft. with vegetation peculiar to sandy tracts. There is no soil 

down to the lowest depth except sand; bitter water is, however, sometimes found at depth of about 

80-100 ft.The Potohar Upland, commonly called the Potohar Plateau, lies to the south of northern 

mountains and is flanked in the west by River Indus and in the east by River lhelum. This 1,000-

2,000 ft.(305-610 m) upland is a typical arid landscape with denuded and broken terrain 

characterised by undulations and irregularities. These are a few outlying spurs of Salt Range in the 

south, and those of Khair Murad and Kala Chitta Range in the north. Two seasonal streams-Rivers 

Haro and River Soan-flow from east to the west and after crossing the region in the north and in the 

middle respectively, fall in the Indus. River Kanshi traverses the eastern part of the plateau from 

north to south and drains into River lhelum. These rivers and other hill torrents have cut deep valleys 

and are of little use for irrigation. Agriculture is thus almost entirely dependent on rainfall of 15-20 

inches and on the small dams built in the catchments areas of the streams. 
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BRIEFHISTORY 

Pakistan. To the north of the Punjab is the NWFP (North West Frontier Province) 

and the Federal capital area of Islamabad. To the north east is the Azad Kashmir. To its 

east and south is India (Indian Punjab & Rajesthan). To the south west is the province of 

Sind. To the west is Baluchistan Province and the Federally Administered Tribal Areas 

(FATA). The province is predominantly on level plain. There are, however, some 

mountainous and hilly areas in the northwest and extreme southwest. There is also a 

plateau adjacent to the mountains known as the Potohar plateau and a desert belt in the 

south eastern part known as Cholistan. All the major rivers of the country namely Indus, 

Jhelum, Chanab, Ravi, & Sutlaj flow through this province. They originate from the 

Himalayas and pass from north west to south west. They are primeval in nature and the 

volume of water increases in summer after monsoon rains, resulting sometimes in floods. 

Punjab is the most populous province of Pakistan. According to 1998 census, the 

population of the Province is 7,25,85,000. The population density is 353 persons per 

square kilometer as compared to the national figure of 164. It contains several major cities 

of the country: Lahore, Faisalabad, Rawalpindi, Multan and Gujranwala. In religion, the 

province is almost entirely Muslim, with a small Christian minority. Punjabi is the mother 

ongue of 90 percent of the population. he main language used in writing is Urdu, followed 

by Eng lish. The major ethnic groups are the Jat, Rajput, Arain, Gujar and Awan . The 

Province of Punjab comprises eight Administrative Divisions and 34 districts. It extends 

over an area of 2,05 ,345 square kilometers (97,192 square miles) which is 25.8 percent of 

the total area of Pakistan. 

CULTURE 

Punjab has been the cradle of civilization since times immemorial. The ruins of 

Harappa show an advanced urban culture that flourished over 5000 years ago. Taxila, 

another historic landmark also stands out as a proof of the achievements of the area in 

learning, arts and crafts in bygone ages. The forts, palaces, gardens, mosques, 

mausoleums, are eloquent reminders of the great tradition in Muslim architecture. They 

remind of the glorious Muslim tradition in the area which bequeathed to the province a 
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culture which is essentially Islamic in nature. The structure of a mosque is simple and it 

expresses openness. Calligraphic inscriptions from the Holy Quran decorate mosques and 

mausoleums. The inscriptions on bricks and tiles of the mausoleum of Shah Rukn-e-Alam 

(1320 AD) at Multan are outstanding specimens of architectural ca ll igraphy. The earliest 

existing building in South Asia with enameled tile-work, is the tomb of Shah Yusuf Gardezi 

(1150 AD) at Multan. A specimen of the sixteenth century tile-work at Lahore is the tomb of 

Sheikh Musa Ahangar, with its bri lliant blue dome. The tile-work of Emperor Shah Jahan's 

reign is of a richer and more elaborate nature. The pictured wall of Lahore Fort is the last 

line in the tile-work in the entire world .. 

CAPITAL 

LAHORE 

Situated on the east bank of the River Ravi, the wonderful city of Lahore adds to the 

c arisma 0 Pakistan. Legend traces its origin to Loh, the son of Rama Chandra , the hero of 

the Ramayana, but history reco ds ha it began as a dependency of the 8th century AD 

Hindu ruler, Lalitiditya. In the early 11th century it came under Muslim rule and evolved as a 

center of Islamic culture and learning as well as trade and commerce. In the 13th century it 

was depopulated and razed to the ground by the Tartar-Mongol hordes of Genghis Khan. 

Lahore was a cultural and intellectual center during the Mughal and British eras. Such 

atmosphere still pervades, but it is the diversity and contrast of the different sections of 

Lahore, which makes it the most eventfully interesting part of Pakistan. Lahore is the 

second largest city of Pakistan and the provincial capital of Punjab. Apart from being the 

cultural and academic centre of the country, Lahore is the Mughal "show-window" of 

Pakistan. In the Mughal days a 9-meter high brick wall surrounded the Old City. It had a 

rampart running around it which almost connected with the River Ravi to serve as 

protection for the city. A circular road around the rampart gave access to the city through 

thirteen gates. Some of the imposing structures of these gates are still preserved. In the 

bazaars of the Old City one can sti ll find tiny shops where craftsmen can be seen busy 

turning out master-pieces in copper, brass, silver and textiles in traditional fashion. In 
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modern days, Lahore hosts a large number of industrial units running day and night to play 

their vital role in developing the country's economy. Lahore is also an important center of 

. journalistic activities. A large number of newspapers, journals and magazines are published 

here. Lahore is a great commercial and trade center. It has combined the life style of east 

and west and presents a lively mixture of some old and new patterns of life. The most 

important historical monuments of the Moghul's in ahore are; the Royal Fort (Shahi Qila), 

the Badshahi Mosque. The Independance monument, the tombs of emperor Jehangir, Noor 

Jehan, Anarkali, Asif-Jah and the famous Shalimar Gardens. In the old part of the town and 

off the Kashmir Bazaar, reputedly the most beautiful Mosque of South Asia is located, the 

"Wazir Khan's Mosque'. It is a marvellous specimen of tile work and arabesque paintings. 

The Imperial or the Badshahi Mosque is accross the courtyard from Alamgiri Gate of the 

Lahore Fort. The Mosque, made up entirely of red sandstone, was built by Emperor 

Aurangzeb. 5 kms east of old city, are the famous Shalimar Gardens laid out by Mughal 

Emperor Shah-Jehan in 1642 AD. The Gardens are set out in typical Mughul style and are 

surrounded by high walls with watchtowers at the four corners. The Golden Mosque is also 

situated in the Kashmiri Bazaar. It was built in 1753 AD. by Nawab Syed Bhikari Khan who 

was Deputy Governor of Lahore. The ashes of the Sikh ruler of Punjab, Maharaja Ranjeet 

Singh, and of his four wives lie in a dome adjacent to the Hazoori Bagh and is famously 

known as 'Samadhy of Maharaja Ranjeet Singh'. Apart from these there are certain Shrines 

and Mausoleums like the Shrine of Data Sahib (Hazrat Ali Hajveri), the Mausoleum of 

Emperor Jehangir, Asif Khan's (Jehangir's brother-in-law) Mausoleum, Empress Noor 

Jehan's (light of the world) Tomb whose name appeared on the coins of the Mughal 

Empire, Qutbuddin Aibak's Tomb, Anarkali's Tomb and the tomb of Allama Muhammad 

Iqbal who has been hailed as the poet-philosopher of the East. Lahore is a city ful l of life 

and color. It has something for everyone. Large number of beautiful gardens, historically 

exotic forts, mosques and shrines, mug hal architectures and museums, shopping centres, 

fairs and festivals all add-up to make Lahore as Pakistan's most surprisingly colorful 

package. 
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PEOPLE OF PUNJAB 

Because of its strategic location in the Indian sub-continent, wave after wave of 

migrants poured into the area and settled on its fertile lands and today, although originally 

belonging to the Aryan stock, the people of Punjab are descendants of the Iranians, Turks, 

Afghans and Arabs who came individually or in groups. The people of Punjab ethnically 

belong to a pluralistic pattern of life. But they have a common identity. They have one 

common faith - Islam - and they proudly share its glorious traditions in their thought and 

conduct. In their religious sensibility, in folklore, in regional and domestic culture and in their 

hopes and aspirations the people have a common identity. The dialects spoken in different 

regions of the land have a common vocabulary and a shared heritage. The people of 

Punjab have also a shared spiritual experience which has been disseminated by 

Tassawwaf and can be witnessed on the occasion of the remembrance-fairs held on the 

Urs of great Sufi Saints. The people mutually share a living tradition of values. Their 

traditional hospitality and love for strangers is an obvious feature of their character and 

behavior. They are loving people and know the courteous way of returning love to others. 

FAIR AND FESTIVAL 

The culture of Punjab derives its basis from the institution of sufi saints. The sufi 

saints spread Islam and preached and lived the Muslim way of life. People have the funs 

and festivities to commemorate these traditions. The fairs and festivals of Punjab reflect the 

entire gamut of its folk life and cultural traditions. These mainly fall in three categories 

consisting of (i) religious & seasonal fairs/festivals, (ii) devotional fairs or Urs and (iii) 

industrial and commercial fairs. Religious fairs are held on special days of Islamic 

significance like Muharram, Eid Milad-un-Nabi, Eid-ul-Fithr, Eid-ul-Azha and Shab-e-Brat. 

The main activities on these special occasions are confined to congregational prayers and 

rituals. Melas are also held to mark these occasions. The fairs held at the shrines of Sufi 

saints are called Urs. They generally mark the death anniversary of the saint. On these 

occasions devotees assemble in large numbers and pay homage to the memory of the 

saint. Soul inspiring music is played and devotees dance in ecstasy. The music on these 
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occasions is essentially folk and appealing. It forms a part of the folk music through mystic 

messages. The most important Urs are: Urs of Data Ganj Bukhsh at Lahore, Urs of Hazrat 

Mian Mir at Lahore, Urs of Baba Farid Ganj Shakar at Pakpattan, Urs of Hazrat Bahaudin 

Zakria at Multan, Urs of Sakhi Sarwar Sultan at Dera Ghazi Khan, Urs of Shah Hussain at 

Lahore, Urs of Hazrat Bullehe Shah at Kasur and Urs of Hazrat Imam Bari (Bari Shah Latif) 

at Rawalpindi-Islamabad . A big fair is organized at Jandiala Sher Khan in district 

Sheikhupura on the Mausoleum of Syed Waris Shah who is the most loved Sufi poet of 

Punjab due to his work known as Heer Ranjha. Exhibitions and Annual Horse Shows in all 

Districts and National Horse and Cattle Show at Lahore are held with the official patronage. 

National Horse and Cattle Show at Lahore is the biggest festival where sports, exhibitions, 

and livestock competitions are held. It not only encourages and patronizes agricultural 

products and livestock through the exhibitions of agricultural products and cattle but is also 

a colorful documentary on the rich cultural heritage of the Province with its strong rural 

roots. 

ART AND CRAFT 

The crafts in the Punjab are of two types: the crafts produced in the rural areas and 

the royal crafts which flourished in the urban centers particularly in Lahore. The former 

include cotton textiles, basketry, embroidery etc. while the latter are tile and woodwork 

skills, ivory, silver and gold work, naqqashi and architectural crafts. Hand knotted carpets of 

fine quality are made in Punjab since the Mughal period. Emperor Akbar in the 15th century 

established the first factory in Lahore. While carpets were made for the rich, rough rugs 

(known as namdas) were made by the common people for their own use. Lahore is the 

center of hand-made carpets. Since ancient times the weavers of the region have produced 

colourful fabrics of silk and cotton. The hand-woven cotton cloth like khaddar of Kamalia , 

are popular. The cloth woven on handlooms is either block printed or beautifully 

embroidered. Multan is famous for beautiful hand-woven bed covers. The potter at his 

wheel is a common sight in every village, uninfluenced by modern glamour. Bahawalpur, 

Rawalpindi and Gujrat also produce colourful pottery, painted after firing. The blue glazed 
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pottery of Multan dates back to the 13th century with obvious traces of Persian influence. 

Chiniot, Gujrat and Lahore are famous for woodwork. Chiniot is known for woodcarving and 

furniture, brass and iron inlay. Copper and brass work is done within the walled city of 

Lahore since ages. In fine arts, the local Muslim traditions of Punjab were greatly influenced 

by the works of Central Asian and Persian artists of the early Mughal period . Persian 

miniatures are the models of some of the well-known artists like Abdur Rehman Chaughtai, 

with a style of his own, and Haji Muhammad Sharif. Among the modern artists, Ustad Allah 

Bakhsh, Khalid Iqbal, Ijazul Hasan and Shakir Ali stand on the top. In calligraphy, a great 

heritage of Muslim art, Agha Mirza Imam of Lahore gave new dimensions to this art and 

was followed by equally renowned Sufi Abdul Majid (Perveen Raqqm) and Abdul Walid 

(Nadir Qalam) who changed the round form of letters to elegant ovals. In the Graphic Arts, 

representational paintings and landscapes continue to be produced side by side with more 

complex modern trends. The main art centers in the province are AI-Hamra, the National 

College of Arts, Fine Arts Department of the Punjab University and the Lahore Art Gallery, 

all located at Lahore 

JO CITIES 

Faisalabad 

Faisalabad is the third largest city of Pakistan after Karachi and Lahore located in the 

province of Punjab. Untill 1979 Faisalabad was formerly called Lyallpur, after Sir Charles 

James Lyall, lieutenant governor of the Punjab. It became headquarters of the Lower 

Chenab colony and in 1898 was incorporated as a municipality. It is also known as " Little 

Manchester" because of its textile mills, it has grown rapidly in just a century and is famed 

as the University of Punjab's Agriculture campus (established 1961). 

The city was founded in 1890 and offers little of interest to the tourist. Sir Charles 

James Lyaillaid out the town in the shape of the British flag : a rectangle with across and 

two diagonals; a clock tower stands at the crossroads. 
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Its most distinguished feature (now indescribably filthy) is the town center which was 

laid out patriotically by Sir James Lyall in the shape of the British fJag----a rectangle 

containing a cross and two diagonals. At the center is a clock tower where eight roads 

meet. These eight segments form the town's main bazaars. 

Gujranwala 

Gujranwala city appears to be 500 years old. The origin of the name Gujranwala is 

shrouded in mists of time. The first name of the settlement according to the compi lers of 

the first edition of the district Gazette was khanpur Shansi after an individual of the JAT cast 

called Khan Shansi who founded 11 villages in the nearby area. For some reason the Jaat 

Tribe Gujar occupied the land. They reach such dominance that the town came to be 

known as Gujranwala. The Compi lers of the district Gazetteer Gujranwala date this name 

to Approximately 300 years , giving us a rough estimate of the middle of the 16th century . 

Other smaller town in the vicinity for example Sohdara Eminabad Wazirabad and Ghakkar 

have I er antecedent than G jran ala itself. In the indispensable 1969 Essay " 

Gujranwala ; past and present" Dr.Waheed Quereshi names four villages in the Vicinity at 

the time of Abdalies invasion i.e. in the late18th century. 

Gujranwala now is an agricultural marketing center (grains, melons, sugarcane), it is also a 

commercial and industrial center, manufacturing ceramics,iron safes, copper, brass, and 

aluminum utensils. The establishment of an industrial park, textile, silk, pipefitting, electric 

fan, and tannery production increased its importance. Cultivation in the surrounding area is 

dependent upon canal irrigation. Wheat, cotton, rice, barley, and millet are the chief crops. 

World's best Quality Rice grows here. In 1951 the city was converted into the capital of the 

district which Gave rise to the new industries in the city. The Gujranwala hydroelectric 

project provides power from the Chanab River. There are also rice and sugar mills and 

glassworks in the locality. City has an International Level Cricket Stadium, Jinnah Stadium 

also or formerly known as Municipal Stadium. Gujranwala, chamber of commerce & 

industry came into being. In November 1978, and the first elected executive committee 

(Majlis-a-Aamla) took the charge of the chamber. In all over Pakistan GCCI is one of those 

chambers who have their own building. The credit of construction of chamber's building 
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undoubtedly goes to its founders. Now apart from the chamber office, the Zonal I Circle 

offices of Habib Bank Limited, United Bank Limited, Allied Bank Limited and State Bank of 

Pakistan are functioning in the building. The city has many hospitals and several colleges 

affi liated with the University of the Punjab. 

Islamabad 

Islamabad, the capital of Pakistan, is located against the backdrop of Margalla Hills 

at the northern edge of Potohar Plateau. In contrast to its twin city Rawalpindi, it is lush 

green, spacious and peaceful. Islamabad is a city of wide, tree-lined streets, large houses, 

elegant public buildings and well-organised bazaars. Traffic jams and crowds are rare, and 

narrow lanes and slums are few and far between. Sidewalks are shaded and safe behind 

rows of flame trees, jacaranda and hibiscus. Roses, jasmine and bougainvillaea fill the 

many parks, and scenic view-points show the city to its best advantage. The master plan of 

this most modern city was prepared in 1960 by Mis. Constantinos Doxiades, a Greek firm 

of Architects. Construction was started in October 1961. The city came into life on 26 

October, 1966, when the first office building of Islamabad was occupied . It is a modern and 

caref Ily planned city. There are ample opportunities for walking, joggi g, iki gad 

trekking around Islamabad in the Margalla Hills. The Margalla Hill range offers excellent 

opportunities for short and long hikes with magnificent vistas opening up on all sides. A 

net-work of trails having more then 120 kms total length has been developed. 

MULTAN 

About 966 km from Karachi and more or less right in the centre of the country lies 

the ancient city of Multan. Multan, the 'City of Pirs and Shrines' is · a prosperous city of 

bazaars, mosques, shrines and superbly designed tombs. It is also a city of dust, summer 

heat and beggars. It has a long history. Alexander the Great added it to his list of Indus 

conquests. In 641 AD Xuang Tzang found it 'agreeable and prosperous' - Mohammad Bin 

Qasim obviously agreed, he was the next to conqueror Multan in 712 AD. Mahmud of 

Ghazni invaded in 1006, Timurlane in 1398. In the 16th century it was the Moghuls turn, 

followed by the Sikhs in 1752 and the British in 1849. The old city has narrow colourful 
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bazaars full of local handicrafts and narrow winding lanes. There are many places of 

historical, cultural and recreational interest in the city 

MUREE 

Murree, at 2,240 meters (7,400 feet) , is only an hour's drive north-east of Islamabad. 

Its cold pine forests, amidst magnificent mountain scenery, make it the first choice 

for a day's outing from the capital. The Galis are a string of hill resorts along the 

ridge between Murree and Abbottabad, on the Karakoram Highway. Founded as a 

hill station by the British in 1851, Murree was the summer headquarters of the 

government of Punjab until 1876, when the honour was transferred to Simla. Murree 

remained, however, a little bit of England, complete with The Mall for promenading, 

parks, churches, schools, clubs and cafes. Since independence, Murree has once 

again become the summer retreat of the governor of Punjab and , since Islamabad 

became the capital of Pakistan in 1962, has expanded rapidly. 

Murree is lovely all year round . In summer it is cool - even chi lly in the evening - and 

rain is common . In winter, the snow is piled high along the sides of the streets. But 

it is extremely popular with Punjabis escaping the heat of the plain in s mmer, s is 

too crowded for comfort from late May to early September, especially at weekends. 

To beat the crowds and still enjoy the walks, the best time to go in April-May and 

September-October. Murree spreads along the top of a ridge for about five 

kilometres (three miles). At the north-east end is Kashmir Point, with views across 

the valley of the Jhelum River into Azad Kashmir. At the south-west end is Pindi 

Point, looking back towards Rawalpindi and Islamabad. Between the two runs The 

Mall, at the centre of which is the main shopping area, where most people 

congregate. Numerous roads leave. The Mall and either follow the contours of the 

ridge or descend to the principal road. Promenading and shopping are Murree's 

main amusements, or riding in the new chair-lifts, one from Bansara Gali (below 

Murree) to Pindi Point, the other to the top of Patriata hill (on the road to Karor); both 

rides cost about Rs. 50 and take half an hour with a change from open chair-lift to 

the enclosed bubble in the middle. Good buys in Murree are Kashmiri shawls, furs, 

walking sticks, fruits and nuts. Murree's pistachio nuts are reputed to be the best in 
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Pakistan. 

Bhurban 

Bhurban is a minor resort eight kilometres (five miles) from Murree on the road 

leading north-east to Kohala and the Jhelum Valley. The golf course here is open only to 

members. From near the Pearl Continental hotel you can take one of the many delightful 

paved walks through the woods. 

Rawalpindi 

Rawalpindi lies on the Grand Trunk Road 177 from Peshawar and 275 kms from 

north-west from Lahore. The twin city of Rawalpindi/Islamabad lies against the backdrop of 

Margalla Hills on the Potwar Plateau. On the basis of archaeological discoveries, 

archaeologists believe that a distinct culture flourished on this plateau as far back as 3000 

years. The material remains found on the sight of the city of Rawalpindi prove the existence 

of Buddhist establishment contemporary to Taxila but less celebrated than its neighbours. 

It appears that the ancient city went into oblivion as a result of the Hun devastation . the first 

Muslim invader, Mahmood of Ghazni (979-103 A ), gifted the r ined city to a Gakkhar 

Chief, Kai Gohar. the town, however, being on invaders' route, could not prosper and 

remained deserted until Jhanda Khan, another Gakkhar Chief, restored it and gave the 

name of Rawalpindi after the village Rawal in 1493 AD. Rawalpindi remained under the rule 

of Gakkhars till Muqarrab Khan, the last Gakkhar ruler, was defeated by Sikhs in 1765 AD. 

Sikhs invited traders from other places to settle here. This brought the city into prominence. 

Sikhs lost the city to British in 1849 AD. It then became the General Headquarters of British 

Army and they established a cantonment south of the old city. In 1879, the Punjab Northern 

Railway was extended to Rawalpindi but the train service was formally inaugurated on 

January 1, 1886. Over the years, Rawalpindi has retained to traditional flavour. However, 

some modern residential areas and buildings have come up all over the town since the 

creation of Pakistan. Pakistan's new capital, Islamabad being the twin city of Rawalpindi, 

equally shares the same archaeological and historical background. The best way to see 

Rawalpindi is by wending through its bazaars, but you should orient yourself before setting 

out. The city has two main roads: the Grand Trunk Road runs roughly from east to west and 

is known as The Mall as it passes through the cantonment; Murree Road breaks north from 
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The Mall , crosses the railway and brushes the east end of the old city on its way to 

Islamabad. the two main bazaar areas are Raja Bazaar in the old city and Saddar Bazaar, 

which developed as the cantonment bazaar between the old city and the Mall . The 

cantonment evokes the Briti sh Raj, with its Christian churches and cemetery, spacious 

bungalows, club, cricket ground, mall and the cOlonial-style Flashman's Hotel. Behind 

Flashman's is Saddar Bazaar, the centre not only for shopping but also for hotels, banks, 

airlines and travel agents. The heart of the bazaar is along Kashmir Road and Massey 

Gate. The Army Museum, near the Pearl Continental Hotel, houses a fine collection of 

weapons, uniforms and paintings depicting Pakistan's military history. Hours are 9 am to 3 

pm in winter, 8 am to noon and 5.30 pm to 7 pm in summer 

Sialkot 

Sialkot is a city situated in Punjab province of Pakistan. It is located near Indo-Pak 

border, about 125 k.m. from Lahore, the capital of Punjab. This city is centries old . 

According to tradition, it was constructed by Raja SuI. Famous Fort of Sialkot is still there 

but it is in the shape of a small hill now. 

Sports goods, surgical instrum n , m sical instruments and leather gar e are 

manufactured here and exported all over the world. These products are considered the 

best in quality throughout the world . The city of Sialkot is believed to have been founded by 

one Raja Sui or Sali3, the uncle of Pandhavas, whose heroic deeds are recorded in the epic 

Mahabharta. After his death some 5000 years ago, there is a tradition that the dynasty 

continued for some 1500 years and then the country was flooded and remained one vast 

uninhabited region for about 1000 years. The popular belief is that it was re-founded in the 

reign of Vikramaditya of Ujjain by Raja Salivahan or Salban, who built the fort and city and 

gave the place its present name. He was of Sia caste, and it is believed that the word 

"Sialkot" means 'the fort of Sia'. Legend also says the Salivahan had two sons; one Puran 

by name, was killed by the instrumentality of a wicked step-mother, and thrown inot a well, 

still the resort of pilgrims near Sialkot , called "Puran ka Kunwna", the well of Puran . (A 

Mohalla in the city is also named "Puran Nagar") Other son of Salivahan , Rasalu, became 

involved in wars with Raja Hudi, popularly stated to have been a Gakkhar chieftain. Being 

worsted in battle, Rasalu, as the price for piece, was forced to give his daughter in marriage 
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to his conqueror, who gave the territory he had conquered to Rasalu 's adopted son . 

Accord ing to another legend narrated to Mr. Prinsep: 

"After the death of Raja Rasalu, the country is said to have fallen under 

the curse of Puran, for 300 years lying totally devastated from famine 

and incessant plunder." 

Taxila 

Thirty kilometres north-west of Rawalpindi out along the Grand Trunk Road lies 

Taxila, one of the most important archaeological sites in the whole of Asia.Situated 

strategically on a branch of the Silk Road which linked China to the West, the city flourished 

both economically and culturally. Taxi la reached its greatest heights between the 1 st and 

5th centuries A.D.Buddhist monuments were erected throughout the Taxila Valley which 

was transformed into a religious heartland and a destination for pilgrims from as far a fie ld 

as Central Asia and China. Undoubtedly badly shaken by the arrival of Huns into the area in 

the mid-5th century A.D., the city plunged into decline when quarrels among the nobility 

undermined royal power in the 6th and 7th centuries. The remains of the valley can still be 

visited today where many Buddhists monasteries and temples still stand today. 

SINDH 

The Sindh plain comprises mainly the province of Sindh and stretches between the 

Punjab plain and the Arabian Sea. River Indus flows here as a single river and the plain 

comprises a vast fertile tract stretching westward from the narrow strip of flood plain on the 

right bank of River Indus, and a vast expanse of desert stretching eastward from the left 

bank. The desert area is dry and desolate like Cholistan in the Punjab plain . But, the plain 

area right of River Indus is green with a vast stretches of vegetation lined everywhere with 

avenues of trees . It is the heart of the Indus Valley Civilization dating back to 3rd millennium 

B.C. Thousands of tourists from allover the world are attracted every year to visit the ruins 

of Moenjodaro near Larkana. An elaborate canal system taken from Sukkur Barrage at 
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Sukkur, Upper Sindh Barrage north of Sukkur at Guddu, and Lower Sindh Barrage (Ghulam 

Muhammad Barrage) at Hyderabad, irrigate together in this area over 10,000,0000 acres 

and account for about 40 per cent of Pakistan's irrigated land . The fertil e area yields 

abundant crops of ri ce, wheat and cotton and contains the bulk of the population and most 

of the major commercial and industrial centres of Sindh such as Hyderabad(795,000), 

Sukkur (193,000), Larkana (123,000), Nawabshah (102,000), Shikarpur (88,000) and Dadu 

(39,000). 

However, its southern part is one of the worst areas of Pakistan for waterlogging and 

salinity. There are many lakes in Sindh ,which attract thousands of migratory birds during 

the winter season from Central Asia . Manchhar lake with its highly pulsating expanse of 

about 200 sq. miles of area is the largest lake. With its foliage of towering grasses, its 

meadows of floating lotus, its inhabitants in their floating habitations, the lake presents an 

attractive look. Further south, stretches the Indus Delta, which is a savage waste. An 

important feature is the Kinjhar Lake near Thatta, which acts as a great reservoir for 

feeding canals in the adjacent areas. During winter, it is an ideal spot for fishing and duck 

shooting. S th f the Kinjhar Lake, the s rface is broken and littered with abandoned 

channels of distributries, sandy beaches, ridges and mangrove swamps, all merging into 

the dead creeks, grate and salt water of the coast of Rann of Kutch. At the extreme north­

western end of the delta stands Karachi, the largest city and the industria l and commercial 

hub of Pakistan. It is also the port for Pakistan and terminal of Pakistan's railway system 

and the site of the country's principal international airport. Climate and Seasons As 

Pakistan is located on a great landmass north of Tropic of Cancer, between latitudes 24 

and 37 N, it has a continental type of climate, characterized by extreme variations of 

temperature. The areas closer to the snow-covered northern mountains are cold . 

Temperatures on the Balochistan Plateau are comparatively high. Along the coastal strop, 

the climate is modified by sea breezes. In the rest of the country, temperature rises steeply 

in the summer and hot winds, called "100", blow across the plains during the day, dust 

storms and thunder storms occasionally lower the temperature. The diurnal variation in 

temperature may be as much as 11 to 170C. Winters are cold with minimum temperature 

of about 40C in January. Rainfall Pakistan experiences a general deficiency of rainfall. 
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LOCATION AND AREA 

Pakistan consists of four provinces. Its second largest province is known as Sindh 

with its capital in Karachi, which is not only the most populous metropolis of the country, but 

also, a commercial hub. 

The province of Sindh has two gigantic seaports and both are located in Karachi. 

The biggest international airport of Pakistan is also situated in Karachi and is widely known 

as Qaid-e-Azam International airport. 

The Province of Sindh forms the lower Indus basin and lies between 23 to 35 Degree 

and 28-30, north latitude and 66-42 and 71-1-degree east longitude. It is about 579 kms in 

length from north to south and nearly 442 kms in its extreme breadth (281 kms average). It 

covers 1,40,915 square kms and is about as large as England. 

Sindh is also proud of having acquired fame as Bab-ul-Islam (Gateway to Islam in 

the Indo-Pakistan subcontinent) . At the time of the independence from the British 

occupation in August 1947, the population of Sindh was estimated at 5.5 million. Today, 

after the passage of fifty years the population of the province stands around 40 million 

souls, a half of whom now live in the urban centres like Hyderabad, Sukkur, Mirpurkhas, 

Tando Adam, Nawabshah, Larkana, Shikarpur, Khairpur, Badin and other smaller towns. It 

is basically an agrarian province. The Indus is by far the most important river of the 

province. The classical name of the river was Sindhu (Sanskrit for an ocean) and Sindh 

province was created and sustained by the river, without which it would have been a desert. 

Its length is about 2,880 kilometers and nearly a third of that (about 944 Kms) traverses the 

province. The striking resemblance of Sindh to Egypt was noticed long before the existence 

in it of a comparable great prehistoric civi lization was even suspected; the idiosyncrasy of 

its people when compared with Indians, is very marked . There is an ancient saying "Just as 

Egypt is the gift of Nile, Sindh is the gift of the Indus". 

Owing to its prevalent aridity and the absence of the monsoons, the climate of Sindh 

ranks among the hottest and is most variable. The average temperature of the summer 

months is 35 degrees centigrade and those of inter months 16. But the thermometer 

frequently rises in summer to 45 and occasionally to 50.ln the northern part of Sindh the 
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extremes of temperature are strongly marked. Jacobabad boasts of the highest 

temperature yet recorded at a Pakistani meteorological station i.e.52 degrees centigrade in 

June 1919. Sehwan is another hot place while Hyderabad is on the average pleasant due 

to cool breeze. 

Cotton, ri ce, wheat and sugarcane are the main crops produced in Sindh. Rice is by 

far the most important crop cultivated here. It is the only crop that can be grown in the 

annually inundated lands within the delta of the Indus and a larger quantity and much finer 

quality is produced in the Larkana district. In Jacobabad, Sukkur, Badin, Thatta and Oadu, 

also, a great quantity of rice is cu ltivated. Cotton is produced mainly in Sanghar, 

Nawabshah, and Hyderabad, Sugarcane is another important crop which is chiefly grown in 

the Ghulam Mohammad Barrage zone in South. Sindh is proud of its bananas and 

mangoes also. 

The waters around Karachi are rich with seafood and are considered to be some of 

the best fishing spots in the world. Surmai, pomphret, lobsters, shrimps, sharks, dolphins, 

crocod iles and other aquatic life especially Pallas exists in plenty in the sea as well as in the 

sweet waters of the Indus, Manchar, Keenjhar, Haleji and other lakes. 

Within the last 45 years, three irrigation barrages have been constructed across the 

Indus in the province. The command areas of the three barrages are: Sukkur barrage 3.1 2 

million hectares, Kotri barrage 1.1 2 million hectares, and Guddu barrage 1.172 million 

hectares. 

The province of Sindh had traditionally been rich in wildlife heritage. Its Kirthar 

National Park, about 70 k.m. of North West of Karachi, is enlisted on World Heritage. Other 

side at Haleji Lake and Thar area are also of paramount importance. 

Though chiefly an agricultural and pastoral province, Sindh has a reputation for 

textiles, pottery, leatherwork, carpets etc. The craftsmanship of the people of Sindh began 

during the period of Moenjodaro civi lization. Their polished ornaments and articles of 

apparel made out of muslin and wooden lacquer work have won the praise in and outside 

the country 
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HISTORY 

The province of Sindh has been designated after the river Sindh (Indus) which 

literally created it and has been also its sole means of sustenance. However, the 

importance of the river and close phonetical resemblance in nomenclature wou ld make one 

consider Sindhu as the probable origin of the name of Sindh. Later phonetical changes 

transformed Sindhu into Hindu in Pahlavi and into Hoddu in Hebrew. The Greeks (who 

conquered Sindh in 125 BC under the command of the Alexander the great) rendered 

it into Indos, hence modern Indus.The Indus valley civilization is the farthest 

visible outpost of archeology in the abyss of prehistoric times. The areas constituting 

Pakistan have had a historical individuality of their own and Sindh is the most important 

among such areas. The prehistoric site of Kot Diji in Sindh has furnished information of high 

significance for the reconstruction of a connected story which pushes back the history of 

Pakistan by at least another 300 years, from about 2,500 BC. Evidence of a new element of 

pre-Harappan culture has been traced here. When the primitive village communities in 

Baluchistan were still struggling against a difficult highland environment, a highly cultured 

people were trying to assert themselves at Kot Diji one of the most developed urban 

civilization of the ancient world that flourished between the year 25,00 BC and 1,500 BC in 

the Indus valley sites of Moenjodaro and Harappa. The people were endowed with a high 

standard of art and craftsmanship and well-developed system of quasi-pictographic writing 

which despite ceaseless efforts still remains un-deciphered. The remarkable ruins of the 

beautifully planned Moenjodaro and Harappa towns, the brick buildings of the common 

people, roads, public-baths and the covered drainage system envisage the life of a 

community living happily in an organized manner.The earliest authentic history of Sindh 

dates from the time when Alexander the Great abandoned his scheme of conquest towards 

the Ganges, alarmed at the discontent of his soldiers . He embarked a portion of the army in 

boats, floated them down the Jhelum and the Chenab, and marched the remainder on the 

banks of the river till he came to the Indus. There he constructed a fleet, which sailed along 

the coast towards the Persian Gulf with part of his forces, under the command of Nearchus 

and Ptolemy, whilst Alexander himself marched through Southern Baluchistan and Persia 

to Seistan or Susa. At that time Sindh was in the possession of the Hindus, the last of 

whose rulers was Raja Sahasi, whose race, as is reported by native historians, governed 

the kingdom for over two thousand years. The Persian monarchs were probably alluded to, 
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for in the sixth century BC Sindh was invaded by them, They defeated and slew the 

monarch in a pitched battle and plundered the province and then left. Eight years after his 

accession to the Persian throne, Darius I, son of Hystaspes extended his authority as far as 

the Indus. This was about 513 BC.The Arab conquest of Sindh by Muhammad Bin Qasim in 

712 AD gave the Muslims a firm foothold on the sub-continent. The description of Hiun 

Tsang, a Chinese historian , leaves no doubt that the social and economic restrictions 

inherent in the caste differentiations of Hindu society had however, gradually sapped the 

inner vitality of the social system and Sindh fell without much resistance before the Muslim 

armies. According to AI-Idreesi, the famous city of AI-Mansura was founded during the reign 

of Mansur (754-775 AD) the second Khalifa of the Abbasid dynasty. Khalifa Harun-al­

Rashid (786-809 AD) was able to extend the frontie rs of Sindh on its western side. For 

nearly two hundred years since its conquest by Muhammad Bin Qasim, Sindh remained an 

integral part of the Umayyad and the Abbasid caliphates. The provincial governors were 

appointed directly by the central government. History has preserved a record of some 37 of 

them. The Arab rule brought Sindh within the orbit of the Islamic civilization, Sindhi language 

was developed and written in the naskh script. Education became widely diffused and 

Sindhi scholars attained fame in the Muslim world. Agriculture and commerce progressed 

considerably. Ruins of Mansura, the medieval Arab capital of Sindh (11 kms south east of 

Shahdadpur) testify to the grandeur of the city and the development of urban life during this 

period.ln the 10th century, native people replaced the Arab rule in Sindh. Samma and 

Soomra dynasties ruled Sindh for long. These dynasties produced some rulers who 

obtained fame due to judicious dispensation and good administration.Sindh was partially 

independent and the scene of great disorders ti ll late in the sixteenth century when it failed 

into the hands of Emperor Akbar, and for a hundred and fifty years the chiefs paid tribute, 

but only as often as they were compelled to do so, to the Emperor at Delhi. Later the 

Kalhora clan claiming descent from the house of Abbas and long settled in Sindh produced 

religious leaders of whom Main Adam Shah attained prominence in the 16th century. His 

descendants continued to gather large following and this enabled them to capture political 

power in the north western Sindh under the leadership of Mian Nasir Muhammad. This 

happened in the 2nd half of the 17th century. By the turn of that century, foundations of the 

Kalhora power were firmly laid in the northern Sindh under the leadership of Mian Yar 

Mohammad. During the reign of his son, Mian Noar Muhammad, lower Sindh with Thatta as 

its capital came under the Kalhora administration (11 50 A.H).Under the banner of Mir Fateh 

Ali Khan Talpur, the Balochis defeated the last Kalhora ruler Mian Abdul Nabi in the battle 
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of Halani in 1782 AD. Talpur Amirs regained the parts of Sindh (Karachi, Khairpur, Sabzal 

Kot and Umar Kot) which the last Kalhora chief had conceded to the neighboring rulers. By 

eliminating the foreign interference, which had plagued the Kalhora ru le, and by their 

essentially democratic way of governance, the Talpurs were able to take the people into 

confidence and thus achieved.Great many things within a short period of 60 years. They 

built up an excellent system of forts and outposts guarding the frontiers, extended the 

irrigation system, encouraged scholarly pursuits and educational institutions, and promoted 

trade and commerce internally as well as with the neighboring countries.The British who 

came to Sindh also as traders became so powerful in rest of the sub-continent that in 1843 

Sindh lost its independence falling prey to the British imperialistic policy. The Talpurs were 

defeated on the battlefields of Miani, Dubba and Kunhera and taken prisoners. The 

conquerors behaved inhumanly with the vanquished as they did with the Muslim rulers in 

India. Charles Napier who commanded the troops subsequently became the first Governor 

of the province of Sindh.The British had conquered Sindh from their bases in Bombay and 

Kutch and their supporters were Hindus. Therefore, Sindh was annexed to the Bombay 

Presidency in 1843 and a constant policy to subdue the Muslim majority and to lionize the 

Hindu minority in Sindh was followed . Trade and commerce, Services and education 

became monopolies in the hands of the minority whom with the support of the rulers 

wrought havoc on Muslims. Within a few years forty percent of the Muslim land holdings 

passed on to the Hindu creditors. It was after a long struggle that the cause of Sindh was 

supported by the Quaid-e-Azam Mohammad Al i Jinnah when he brought in his famous 14-

points the demand of Sindh's separation from Bombay Presidency. H.H. Sir Agh Khan, 

G.M. Syed, Sir Abdul Qayyum Khan (NWFP) and many other Indian Muslim leaders also 

played their pivotal rule that was why the Muslims of Sindh succeeded in getting Sindh 

separated from the Bombay Presidency in 1936. 

CULTURE 

Sindh is a repository of varied cultural values and has remained the seat of 

civilization and meeting point of diverse cultures from times immemorial. After 
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Independence on August 14, 1947 with the influx of Muslims from India, its culture has 

progressively assumed a new complexion. Sindh's cultural life has been shaped , to a large 

extent, by its comparative isolation in the past from the rest of the subcontinent. A long 

stretch of desert to its east and a mountainous terrain to the west served as barriers, wh ile 

the Arabian Sea in the south and the Indus in the north prevented easy access. As a result, 

the people of Sindh developed their own exclusive artistic tradition . Their arts and craft, 

music and literature, games and sports have retained their original fl avor. Sindh is rich in 

exquisite pottery, vari egated glazed tiles , lacquer-work, leather and straw products, 

needlework, quilts, embroidery, hand print making and textile design. According to 

renowned European historian H.T. Sorelay, Sindhis had not only contributed to literature 

but also to astronomy, medicine, philosophy, dialectics and similar subjects.Melas (fairs) 

and malakharas (wrestling festivals) are popular. Falconry, horse and camel breeding and 

racing are characteristic pastimes. Sind hi fishermen float earthen pots to catch the palla fish 

in the Indus, bullock cart racing and cockfighting are also typical of the province.Genuine 

love for fellow beings, large hearted ness and hospitality constitute the very spirit of Sindhi 

culture and it is the association of the cultural elements that elevate it and keep aloft its 

banner among the contemporary cultures of South-Asia. Having lived for centuries under 

the changing sway of various dynasties i.e. the Arabs, Mughals, Arghuns, Turkhans and 

Soomras, Sammahs, Kalhoras and Talpurs, Sindhi culture is a fusion of multiple culture 

patterns. These splendor and enrichment are reflected in Sindhi art and architecture, habits 

and customs. The old tombs and buildings in Thatta, Sehwan, Hyderabad, Sukkur and the 

excavations at Bhambore, Brahmanabad and Debal bear ample evidence in support of the 

above statement. These places fostered in their environment, some of the best cultural 

values which were handed down to the inhabitants of the adjoining areas. Today, these 

values form the very foundation of Sindhi culture.The Sind hi language has pure Sanskrit 

basis and is closely related to the ancient Prakrit. Its alphabet contains fifty-two letters. The 

Rev. Mr.G. Shirt of Hyderabad, one of the first Sind hi scholars, considered that the 

language is probably, so far as its grammatical construction is concerned, the purest 

daughter of Sanskrit. It has small sprinkling of Dravidian words, and has in later times 

received large accessions to its vocabulary from Arabic and Persian. After the advent of 

Islam, a number of Sindhi scholars not only wrote books in Arabic on various aspects of 

Islam, but also composed poetry of a high order in that language. During the rule of 

Soomras and Sammas, Sindhis produced excellent poetry, and amongst the earliest and 
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best-known poets we find the name of Syed Ali and Qazi Qadan both of Thatta and their 

younger contemporary, Shah Abdul Karim of Bulrhi, the great-grandfather of Shah 

Abdul Latif Bhitai.Qazi Qadan (870-985 A.H.) introduced Philosophy into Sindhi 

poetry. He has in his poetry laid great emphasis on purity of mind and the study 

of the self. In one of his verses he says, "Even if you master thoroughly the 

great Arabic works Qudoori and Kafia you will only be like an ant sitting within a 

well in a limited environment knowing nothing of the world outside" .Then comes 

Shah Abdul Karim of Bulrhi. In 98 couplets he has explained the intricacies of 

human philosophy. In one of his couplets, he says "The best way of Living in the world is to 

give your heart to the beloved and be bodily connected with fellow human beings".Shah 

Latif and his contemporaries, Shah Inayat, Muhammad Moeen Thattvi Isso Mian and Misri 

Shah, were also pioneers in the field of the well-known Sind hi Kafi Lyric. Others who 

contributed to kafi were Qasim, Hyder Shah, Fazil Shah, Pir Mohammad Ashraf, Assooran 

and Qaleech Beg. Misri Shah is considered to be the undisputed monarch in the domain of 

Kafi. The term Kafi was originally taken from Shah Abdul Latifs waie, which correspond to 

Ghazal. Sachal Sarmast added glory to Kafi in his lyrics. 

CAPITAL 

KARACHI 

Karachi is the capital city of the province of Sindh and the largest city of Pakistan. It 

is situated on the eastern coast of the sh" Arabian Sea and to the northwest of the Indus 

River. Its population is nearly 10 million consisting people of different origins. Karachi, the 

largest · and the most populous city of Pakistan present an interesting and colorful 

combination of the old and new. The narrow twisting lanes and alleys of the old city throb 

with life along-side the wide metalled roads and elegant modern buildings. Within the city, 
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talented artisans with age-old skil ls produce handicrafts of exquisite beauty. Karachi was 

made the capital of Pakistan after Independence. Karachi is the busiest city with great 

activity in the trade, industry, education and other fields of life. It has gone through a 

tremendous change and development in various spheres. With enormous rise in the 

population, several residential colonies have emerged in Karachi accommodating the influx 

of people from other provinces as well. Due to this reason Karachi quickly expanded within 

a short span of time. Karachi is the center of education and other cultural and social 

activities. A great number of prestigious educational institutions are functioning here. It is an 

ultra-modern city, with most modern cinemas, recreational clubs, hotels and restaurants .. 

There are beautiful beaches at Sandspit, Sommiani and Hawks Bay. These places are 

excellent picnic resorts with their tranquil surroundings and provide an atmosphere to rest 

and relax. The opportunities for yachting, water-skiing and cruising are also avai lable here. 

The presence of huge and tall buildings has given it a grandeur and majestic appearance. 

Karachi has a state-of-the-art international airport where flights from all over the world land 

and take off. It has thus become the "Gateway to Pakistan". It is a seaport, which is the 

source of conducting International trade and business. It is considered as commercial and 

industrial capital of Pakistan. It has played a vital and dominant role in erecting Pakistan 1s 

economy on firm basis. Karachi is a Cosmopolitan city with people coming from different 

parts of the world. It is a mingling of old and new, east and west. It has absorbed the charm 

and beauty of modern and conventional way of life. Karachi enjoys great importance 

because the Founder of Pakistan, Quaid-i-Azam Muhammad Ali Jinnah was born here. He 

received his early education in this great city. The Quaid-i-Azam is buried here. The 

Quaid 1s mausoleum is the most important monument in Karachi. It stands in the heart of 

the city with its splendor combining classical oriental architecture with modern way of 

designing. His birthplace, the Wazir Mansion, has been preserved as a national archive. 
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MAJORCITIES 

HYDERABAD 

Hyderabad, 164 km north of Karachi the second largest city in Sind and one of the 

largest in Pakistan. Hyderabad is five km from the eastern bank of the Indus changed its 

course away from Khudabad, at that time the capital of the region, the new capital was 

shifted to Hyderabad. In 1766 the Kalhora ruler constructed a fort half a square km in area 

and it still stands today. In 1843 the British arrived and defeated the Talpurs, completing 

their conquest of Sind.ln the old city, buildings are topped by badgers that look like 

chimneys on roof tops. They catch the cool breezes which blow steadi ly in a south-west 

direction for 40 days from late April each year. Hyderabad is hot for most of the year, 

although in autumn and winter the temperature dips down to around 24 C . In the old 

sections of the town, cows still roam the streets giving it a distinctly mediaeval atmosphere. 

On the northern side of the hill on which Hyderabad is sited there are tombs from the 

Talpurs and Kalhora periods. The tomb of Ghulam Shah Kalhora is one of the finest, 

although its dome collapsed and has now been replaced by a flat roof. Also worth a visit is 

the Institute of Sindhology's museum at the University of Sind. It has displays on all aspects 

of Sind hi history, music and culture depicting the lifestyles of the desert tribes. Infrequent 

GTS buses go to the campus, otherwise take a miniwagon to Jamshoro, across the river 

from Hyderabad, and walk the 1-1/2 km to the university. 
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SUKKUR 

North of Larkana the landscape becomes luxuriant, and in Sukkur the railway line 

and the highway split up, with a road and rail tracks leading north-west to Quetta via Sibi 

and Jacob bad, while another highway and railway line go via Rahimyar Khan and 

Sadiqabad straight to Multan. Sukkur is a sprawling town, with beautiful mosques, gardens, 

shrines and madrazhis (Muslim religious schools). A desert oasis town, similar to Jaisalmer 

in Rajasthan, it also boasts many havelis, however, unlike those of Jaisalmer, the Sukkur 

variety are decorated with geometric, floral designs and painted in a variety of bright, 

contrasting colours.Just across the Indus is Rohri, also fairly prosperous and an important 

rail and road junction. The two towns, 5 km apart and 544 km north of Karachi are linked by 

the Lansdowne and Ayub bridges, which are extremely beautiful. There is a medieval 

mosque with porcelain-tiled walls, and eight km away are remains of the ancient city of Aror 

where Alexander the Great is said to have camped . Worth visiting here is the Minaret of 

Masum Shah. This lighthouse Shaped brick minaret was built by Mir Muhammad Masum,a 

local soldier appointed Nawab of Sukkur by the Mughal Emperor. Akbar the Great. The 

tower is slightly titled and is 84 ft, in height 84 ft, in circumference (at its base) with an 

eq ivalent n mber of step leading p to its top Masum Shah, along with other family 

members is buried in pavilion near the minaret. Nearby is the Faiz Mahal an octagonal brick 

dome structure with arched windows and stone-carved balconies. Another tomb of interest 

is that of Shah Khair-ud-din Jilani a saint and religious scholar 

Thatta 

At one time Thatta was important as Sindh's capital city and as a center of Islamic 

arts. From the 14th century, four Muslim dynasties ruled Sindh from Thatta but in 1739 the 

capital was moved elsewhere and Thatta declined. Some people connect it with Pattala or 

Alexander, but the authorities don't agree. Alexander had rested his weary troops in Pattala. 

In preparation for the near fatal march across the Makran desert in Baluchistan. The 

resemblance probably arose as Pattala was built of timber and so are the old houses of 

Thatta plastered by mud. Today these stand at awry angles. The known history of the town . 

goes back to 600 years. For centuries old Thatta was the capital of Sindh. A new city is 

being built opposite the Makli Hills Hashimabad. 
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Mohenjodaro 

At Mohenjodaro (Mound of dead) in the west bank of the Indus in Sind have been 

found the remains of one of the earliest and a most developed urban civilizations of the 

ancient world. Discovered in 1922 Mohenjodaro once metropolis of great importance 

forming part of the Indus Valley Civilization. Mohenjodaro 4,000 years old brick ruins of the 

Indus Valley Civilization city of Mohenjodaro. At Moen-jo-daro (Mound of the Dead) on the 

West Bank of River Indus in Sind. have been found the remains of one of the earliest and 

most developed urban civilization of the ancient world. Discovered in 1922, Moen-jo-dare 

was once a metropolis of great importance, forming part of the Indus Valley Civilization 

complete together with Harappa (discovered in 1921) in Sahiwal District of the Punjab 

about 1287.48 Kms (800 miles away from Moen-jo-daro. This pre-historic civilization 

flourished from the third till the middle of the second millennium B C. when it mysteriously 

disappeared. The archaeological excavations place Moen-jo-daro among the most 

spectacular ancient cities of the world. It had mud-brick and baked-brick buildings. An 

elaborate covered drainage system with soak pits for disposal bins, a large State granary. a 

spacious pilla ed hall , a college of priests, ala ge and imposing building (probably a palace) 

and a citadel mound which incorporates in its margin a system of solid burnt brick towers. A 

master arch itect or architects skillfully planned this highly developed and organized urban 

settlement. Beneath the citadel, parallel streets. Some 30 feet wide stretch away and are 

crossed by other straight streets, which divide the town into great oblong blocks, each 400 

yards in length and 200 or 300 yards in width. The most imposing remains are those of a 

Great Hall which consisted of an open quadrangle with verandahs on four sides. galleries 

and rooms at the back, a group of halls on the north and a large bathing pool. It was 

probably used for religious or ceremonial bathing. Nearby are the remains of the Great 

Granary, possibly a public treasury where taxes were paid in kind. Testifying to the highly 

developed and artistic sensibility of the Moen-jo-dare people is the discovery of necklaces. 

pendants of beads, earrings and anklets of ivory and mother-of-pearl. vessels of silver, 

copper and bronze and polished stone weights and measures which suggest the existence 

of stringent civic regulations 
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Rohri 

Before crossing the Indus to Sukkur. There is the settlement of Rohri once a place of 

considerable importance and a center for holy men of learning. It boasts of a mosque built 

by an officer of the Emperor Akbar in 1583 and decorated with porcelain tiles. A little to the 

south of Rohri are some picturesque rocks on which stands a building "Satbhain Jo 

Maskan" the legend surrounding it is about Seven virgin sisters. who locked themselves in 

rooms with the vow never to look upon the face of a man. The tomb of seven virgin sisters. 

is a row of small rooms connected by a long passage cut partly of rock and ornamented 

externally with colored tiles. Other historic buildings are the Mu-e-Mubarak building erected 

by Mir Mohammad Kalhora in 1545. It enshrines a gold and jewel encrusted casket 

containing a hair of the Holy Prophet (peace be upon him' Every year on 2nd March. the 

sacred relic is displayed to the public 

THAR DESERT 

The Thar desert is located in the Tharparkar District and is a continuation of th 

Rajasthan arid Zone. The District derives its name from the desert it houses. Of a total area 

of 28. 170 sq.kms (11.404 sq. Miles) most is arid except for the coastal belt on the south. 

The desert area has a colorful heritage with its own distinct folklore, culture, flora, and 

fauna. Some of the major towns bordering the desert are Naukot. Mihi . Nagar Park. 

Chachro. Islamkot and Umarkot that are market centers, situated amidst mud-and-brick 

houses narrow lanes and bazaars. Where good buys are such items as tribal embroidery 

and silver jewel lery. The rest-houses there are a suitable for tourists. August and 

September are the best months for a visit as the area is then at its geenest. Also 

recommended is the period from December to February when daytime temperatures are 

cool and the nights cold. 
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NORTHWEST FRONTIER POST 

Located on both banks of the river Indus, NWFP stretches from the Himalayas in the 

north to the deserts in the south where it is bordered by the Baluchistan and Punjab 

provinces. On its western flank is the rugged terrain of neighboring country Afghanistan, 

which is accessed via the historic Khyber Pass through the mountains of the Sulaiman 

Range. The capital of the province is the city of Peshawar. 

NWFP known as Frontier Province or Sarhad in the local languages has a climate 

ranging from the benign in winters (-10°C to 20°C) when the sun shines and the breeze 

blows sharp and clean from the snows of the mountains onto the plains, to the sweltering 

heat of the summers in the plains when the only refuge can be found in the mountain 

resorts and villages. 

A variety of languages are spoken. Pashtu and Urdu being the most common. 

English is widely understood. Other languages include Hazara, Punjabi, Hindko, Siraiki, 

Chitral i and Kohistani. he prevalent religion is Islam. 

A number of universities and institutes provide education in the field of software 

development and general computer literacy. Amongst these are the Ghulam Ishaq Khan 

Institute (GIKI), University of Peshawar and Gomal University. The graduates of these 

institutions obtain employment within the province and outside. Various software 

companies have cropped up throughout the province, and Information Technology plays an 

important role in the economy and advancement of the people. 

BALUCHISTAN 

To the southwest of Pakistan lies the Balochistan Plateau, an awesome terra in of 

rugged valleys, saline lakes and vast desert wasteland. The largest (area wise) of the four 

provinces of Pakistan, Balochistan is yet the most sparsely populated. 
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The local population comprises hardworking people, accustomed to the extreme 

climatic and arid conditions of the land. They are ethnically diverse people of Pathan, 

Baloch and Barohi origin, intermingled with other migrant races who have been attracted by 

the mining prospects in the province. 

Baluchistan is richly endowed with mineral resources and major occupations are in 

iron and coal mining and oil and gas explorations. The country's largest natural gas 

reservoir is located here at Sui, which , when discovered in 1952, was the largest in Asia. 

Baluchistan is famous for its exotic fruits. Many varieties of fresh and dry fruits are 

supplied to the teeming bazaars of Quetta, the provincial capital, as well as around the 

country. Handicrafts of beautiful and intricate craftsmanship are produced here the most 

typical of the region being the exquisite mirror work, embroidery, fine quality precious 

stones and marble works. 
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SOFTWARE'S USED 

It was decided to put all information in the form of web pages ,so that all can easi ly 

access it. To design web pages ,the best choice that I can chose was to use HTML 

language and to give them an attraction ,sober and scholarly look. The software's 

selected were latest available and comprises of text editor, graphics manipulators, image 

processors and HTML development environment. 

SOFTWARE'S UTILIZED 

LANGUAGES 

• HTML - Hyper Text Markup Language 

Graphic Packages 

• JASC Paint Shop Pro(Version 7.02) 

• ADOBE Photoshop(Version 7.0) 

• F H (Version 5.0) 

Processor Employed 

• Notepad 

• MS word2000 

HTML Editor Used 

• FrontPage 

• Microsoft word2000 

Browser's used 

• Internet explorer(Version6.0) 

Operating system Employed 

• Windows2000 

Hardware Environment 
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To get optimum performance from the software ,the system should be IBM 

compatible Pentium II or higer,Ram32 MB or more. 
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THE INTERNET 

The internet is the world 's largest network. The internet is an outgrowth 

of a network (ARPANET) established roughly a quarter-century ago to meet 

the needs of researchers working in the defense industry in the United States 

and a few of their colleagues in other countries. The ARPANET grew slowly, 

from handful of computers in 1971 to more than 1000 in 1984.Working with 

the ARPNET, researchers came to regard high-speed computer networks as 

an indispensable tool for academic research in all fields, and in 1986 in the 

US National Science Foundation established NSFNET to provide network 

cooperation .In 1987 the Internet served more than 10,000 computers. By 

1989, the network had grown to more than 100,OOO.The internet has now 

spread in all over the world to offer both information access and a fast, 

inexpensive means of communication to the general public. It will be the next 

public utility. 

I o y I E E 

1957 

The USSR launches Sputnik, the first artificial earth satellite. In 

response, the United States forms the Advanced Research Projects Agency 

(ARPA) within the Department of Defense (000) to establish US lead in 

science and technology applicable to the military. 

Backbones: None - Hosts: None 

1962 

RAND Paul Baran, of the RAND Corporation (a government agency), 

was commissioned by the U.S. Air Force to do a study on how it could 

maintain its command and control over its missiles and bombers, after a 

nuclear attack. This was to be a military research network that could survive a 

nuclear strike, decentralized so that if any locations (cities) in the U.S. were 

attacked, the military could sti ll have control of nuclear arms for a counter-

34 



attack. Baran's finished document described several ways to accomplish this. 

His final proposal was a packet switched network. "Packet switching is the 

breaking down of data into datagram or packets that are labeled to indicate 

the origin and the destination of the information and the forwarding of these 

packets from one computer to another computer until the information arrives 

at its final destination computer. This was crucial to the realization of a 

computer network. If packets are lost at any given point, the message can be 

resent by the originator." 

Backbones: None - Hosts: None 

1968 

ARPA awarded the ARPANET contract to BBN. BBN had selected a 

Honeywell minicomputer as the base on which they would build the switch. 

The physical network was constructed in 1969, linking four nodes: University 

of California at Los Angeles, SRI (in Stanford), University of California at 

Santa Barbara, and University of Utah. The network was wired together via 50 

Kbps circuits. 

Backbones: 50Kbps ARPANET - Hosts: 4 

1972 

The first e-mail program was created by Ray Tomlinson of BBN.The 

Advanced Research Projects Agency (ARPA) was renamed The Defense 

Advanced Research Projects Agency (or DARPA).ARPANET was currently 

using the Network Control Protocol or NCP to transfer data. This allowed 

communications between hosts running on the same network. 

Backbones: 50Kbps ARPANET - Hosts: 23 
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1973 

Development began on the protocol later to be called TCPIIP, it was 

developed by a group headed by Vinton Cerf from Stanford and Bob Kahn 

from DARPA. This new protocol was to allow diverse computer networks to 

interconnect and communicate with each other. 

Backbones: 50Kbps ARPANET - Hosts: 23+ 

PROTOCOLS OF THE INTERNET 

Protocols do their work behind the scene. Every message transmitted 

over the internet passes through at least three levels of protocols: a network 

protocol to oversee getting messages from place to place, a transport protocol 

to manage the integrity of what is transmitted and an application protocol that 

turns the network transmission into something that we can recognize as the 

answer to a reques hat wa di patched through a network application. The 

protocol used by the internet for getting messages from one machine to 

another is called the "Internet Protocol". The internet protocol is the network 

protocol, and its job to manage the logistics of getting a message from the 

sending machine to the receiving machine. Messages delivered by the 

Internet Protocol are called "Packets", and they are quite small, fifteen 

hundred or fewer bytes. Since this is much smaller than many of the 

messages and files that are transmitted over the internet, it is common for the 

transmission, to require multiple packets. The key protocols of the Internet 

are: News, Gopher, Telnet, Electronic Mail (e-mail), File Transfer Protocol 

(FTP), and HTIP (World Wide Web). 

HTTP ,.(World Wide Web). 

Underlying the user interface represented by web browsers, is the 

network and the protocols that travel the wires to the servers or "engines" that 
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process requests, and return the various media. The protocol of the web is 

known as HTTP, for Hypertext Transfer Protocol. HTTP is the underlying 

mechanism which directly determines what you can and cannot send or 

receive. 

E-Mail 

Electronic mail, the sending and receiving of electronic messages, has 

long been the most popular use of the Internet. E-mai l is also used on most 

commercial on-line services, and for many people, it's the main reason for 

getting onto the Internet or an on-line service. To send e-mail, you must know 

the recipient's e-mail address. These addresses are composed of 

• the user's identification, 

• followed by the "@" sign, 

• Followed by the location (domain name) of the recipient's computer. 

News 

NNTP (Network News Transfer Protocol) is an Internet standard 

protocol for distribution, inquiry, retrieval and posting of news articles. Network 

News (USENET) is a popular usage of NNTP. It offers bulletin boards, chat 

rooms, and Netnews, which is a massive system with over 5,000 ongoing 

conferences, called newsgroups, conducted around the clock, 365 days a 

year. To access these newsgroups, you download a special program from the 

Internet that allows you to participate in any newsgroup you wish. Most 

commercial browsers have this capability built in. You can "subscribe" to 

those newsgroups that interest you and communicate through a message 

system similar to e-mail. You may simply view an ongoing dialog without 

participating. To join in the conversation, you "post an article" to the 

newsgroup. As with e-mail, Netnews is usually informal communication 

between several of individuals. The "signal-to-noise" ratio can be very low .. 
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Gopher 

Another widely used tool of the Internet is Gopher, a menu-based 

program that enables you to browse for information without having to know 

where the material is specifically located. It lets you search lists of resources, 

and then helps send the material to you. 

When you use Gopher, you navigate the Internet by moving deeper and 

deeper into "menus". The user is presented with a top-level menu, e.g. 

volume numbers; the user would move the cursor to one & press Return, 

which would then present the second-level menu, e.g. chapter numbers; after 

selecting one of these, the next menu is section numbers, etc .. . When the 

user has reached the bottom level, the actual text is displayed. 

This has the advantage of simplicity and familiarity, and it's fairly easy to set 

up - the text files would need to be split down to the desired level of detail, 

and some description files would need to be set up. There is a server, WN, 

that can serve both HTTP and gopher requests. The major disadvantage is 

the inflexibility of the static hierarchy. The user has to use judgment at each 

menu selection, as to which is the most likely item on the menu to contain the 

information required. You can access library catalogs, files, and other 

databases. For example, if you are looking for a poem written by your favorite 

poet, you might look first under authors & books, and then under poetry. 

File Transfer Protocol (.FTP) 

FTP (File Transfer Protocol) allows you to send files to a remote 

computer, or receive them. You can also update (delete, rename, move, and 

copy) files at a server. People who create Web home pages can use FTP to 

get their files to the server where they will be accessed. FTP is included in the 

suite of protocols that are part of TCP/IP, the client/server program that every 

Internet server and your (client) PC or workstation uses. 

You can transfer many different types of files to your computer. You may want 

the latest upgrade for a particular software product, or you might find your 
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favorite movie star's photograph . There are probably millions of files avai lable 

via FTP on the Internet. The search tool Archie, a client program, helps you 

find fi les stored on FTP sites using keywords that appear in the file names. 

You enter likely keywords and Archie searches its database for matches. 

Archie then sends you a list with fu ll file names and the address information 

you need to retrieve the file via FTP. 

Telnet 

Telnet provides a way to "log in" to a remote computer; your keyboard 

and monitor act as if attached to the remote computer. You can use the same 

services as a local user. You can run programs on a computer on the other 

side of the world, just as if you were sitting in front of it. The remote computer 

is frequently called a "host computer" . 

Telnet is a user command using the underlying TCP/IP protocol for accessing 

remote computers. You log on as a regular user with whatever privileges you 

may have been granted to the specific applications and data on that 

computer. Of course, you have to know the operating system and applications 

of the remote computer. 

What is a Browser? 

A browser is a computer program that resides on your computer 

enabling you to use the computer to view VVVWI/ documents and access the 

Internet taking advantage of text formatting, hypertext links, images, sounds, 

motion, and other features . Netscape and Internet Explorer are currently the 

leading "graphical browsers" in the world (meaning they facilitate the viewing 

of graphics such as images and video and more). There are other browsers 

(e.g., Mac web, Opera). Most offer many of the same features and can be 

successfully used to retrieve documents and activate many kinds of 

programs. Browsers all rely on "plug-ins" to handle the fancier files you find on 

the Web. Plug-ins are sub-programs stored within a browser or elsewhere in 
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your computer especially to support special types of files you may click on. If 

you click on a link, and your computer does not currently have the plug-in 

needed for the file you clicked on, you are usually prompted with an 

opportunity to get the plug-in. Most plug-ins are free, and easy and safe to 

install on your computer. The main way in which browsers differ is in the 

convenience features they offer for navigating and managing the Web and all 

the URLs you may want to keep track of. Netscape and Internet Explorer both 

offer the ability to e-mail documents.downloadthemtodiskette.print them, 

and keep track of where you've been and sites 

World Wide Web 

The WVNV incorporates all of the Internet services above and much 

more. You can retrieve documents, view images, animation, and video, listen 

to sound files, speak and hear voice, and view programs that run on 

practically any software in the world, providing your computer has the 

hardware and software to do these things. 

When you log onto the Internet using Netscape or Microsoft's Internet 

Explorer or some other b owse , you a e viewing documents on he World 

Wide Web. The current foundation on which the WVNV functions is the 

programming language called HTML. It is HTML and other programming 

embedded within HTML that make possible Hypertext. Hypertext is the ability 

to have web pages containing links, which are areas in a page or buttons or 

graphics on which you can click your mouse button to retrieve another 

document into your computer. This "click ability" using Hypertext links is the 

feature which is unique and revolutionary about the Web. 

URL 

Every document or file or site or movie or sound file or anything you 

find on the Web has a unique URL (uniform resource locator) that identifies 

what computer the thing is on, where it is within that computer, and its specific 

file name. Every Hypertext link on every web page in the world contains one 

of the URLs. When you click on a link of any kind on a Web page, you send a 
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request to retrieve the unique document on some computer in the world that is 

uniquely identified by that URL. URLs are like addresses of web pages. A 

whole cluster of internationally accepted standards (such as TCP/IP and 

HTML) make possible this global information retrieval phenomenon that 

transcends all political and language boundaries. 
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Introduction to HTML 

Tim Berners-Iee founder of World Wide Web offers the definition 

"Hypertext markup language is simple data format use to create hypertext 

document that are portable from one platform to another". 

Portability and simplicity are the two hallmarks of html.We can create html 

document on any computer that have web browsing software And if we have internet 

and Web browsing software than we easily access these html files from any computer. 

HTML or Hypertext Markup Language is designed to specify the logical 

organization of a document, with important hypertext extensions. It is not designed to be 

the language of a WYSIWYG word processor such as Word or WordPerfect. This 

choice was made because the same HTML document may be viewed by many different 

"browsers", of very different abilities. Thus, for example, HTML allows you to mark 

selections of text as titles or paragraphs, and then leaves the interpretation of these 

marked elements up to the browser. For example one browser may indent the 

beginning of a paragraph , whi le another may only leave a blank line. 

HISTORY 

HTML was originally developed by Tim Berners-Lee while at CERN, and 

popularized by the Mosaic browser developed at NCSA. During the course of the 1990s 

it has blossomed with the explosive growth of the Web. During this time, HTML has 

been extended in a number of ways. The Web depends on Web page authors and 

vendors sharing the same conventions for HTML. This has motivated joint work on 

specifications for HTML.HTML 2.0 was developed under the aegis of the Internet 

Engineering Task Force (IETF) to codify common practice in late 1994. HTMLand 

HTML 3.0 proposed much richer versions of HTML. Despite never receiving consensus 
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in standards discussions, these drafts led to the adoption of a range of new features. 

The efforts of the World Wide Web Consortium's HTML Working Group to codify 

common practice in 1996 resu lted in HTML 3.2 .Changes from HTML 3.2 are 

summarized in A Most people agree that HTML documents shou ld work well across 

different browsers and platforms. Achieving interoperability lowers costs to content 

providers since they must develop only one version of a document. If the effort is not 

made, there is much greater risk that the Web will devolve into a proprietary world of 

incompatible formats, ultimately reducing the Web's commercia l potential for all 

participants. Each version of HTML has attempted to reflect greater consensus among 

industry players so that the investment made by content providers will not be wasted 

and that their documents will not become unreadable in a short period of time. 

HTML has been developed with the vision that all manner of devices should be able to 

use information on the Web: PCs with graphics displays of varying resolution and color 

depths, cellular telephones, hand held devices, devices for speech for output and input, 

computers with high or low bandwidth, and so on. 

hat i T 

HTML is a format in which we can put our information for display on the World 

Wide WeB. Every HTML file is an ASCII text fi le even if it refers to another fom of media 

,such as sound or graphics.We can open an HTML file in a text editr or even a word 

processor. 

To publish information for global distribution, one needs a universally understood 

language, a kind of publishing mother tongue that all computers may potentially 

understand. The publishing language used by the World Wide Web is HTML (from 

HyperText Markup Language) . 

HTML is use to : 

• Publish online documents with headings, text, tables, lists, photos, etc. 

• Retrieve online information via hypertext links, at the click of a button. 
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• Design forms for conducting transactions with remote services, for use in searching 

for information, making reservations, ordering products, etc. 

• Include spread-sheets, video clips, sound clips, and other applications directly in 

their documents. 

HTML IS NOT A PROGRAMMING LANGUAGE 

HTML is not computer programming language like c or c++.With computer 

programming languages, we write programs but with html.We form text and other 

media for viewing .Formatting our documents in HTML has many similarities with 

formatting documents with a word processor. With HTML we can indicate start and end 

of a paragraphs. With Html we can indicate the start and end of a paragraph but we 

cannot know how the user's browser will display paragraph's. Similarly we might choose 

boldface in our word processor to emphasize an important point. But in HTML ,our 

browser's and computer's capabilities determine whether this type of emphasis is 

indicated by a large font ,a different color, italic, boldface or in the formation we use in 

our word documents probably carries a meaning that has an HTML sometimes has an 

aura of mystery and it's secrets are presented as being incredibly arcane 

HTML is actually simple when we think carefully about how to structure our 

information. Many web page authors would argue convincingly that formatting a 

document in HTML is actually easier that preparing a document in our word processor. 

Elements of the HTML Document 

To pass as a va lid HTML document, every web page must consist of five main 

elements:-

• Document Declaration - Declares the markup language and version being 

used. 
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• 

• 

• 

• 

Document Type - Defines the type, also the beginning and end of the file. 

Document Head - Contains the document information (inc\. Document Title). 

Document Title - Logical title for page, contained within document Head. 

Document Body - Text, images, forms, etc, displayed on the page. 

TAGS OF HTML 

Tags are instruction to browsers, telling them how to layout text ,what graphics to 

display where, what distant pages to link to, and a variety of other things. The basic tags 

are as follows: 

• HTML TAGS 

Every document is starts and end with the tag of HTML. 

<HTML> </HTML> 

<HTML> marks the beginning and end of HTML code. It may contain 

HEAD and then BODY. <HTML> must be located immediately after a 

<IDOCTYPE ... > statement. . 

• Title 

The title of a document is specified by the TITLE element, which should be placed in the 

document HEAD. Each document can have only one title, which should identify the 

document content in a general way. 

The Title is not part of the document text and cannot contain hypertext links or special 

markup commands -- it must be simple text. Often the title is used to label the window 
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displaying the text, or is used to label a place in a browser's history or bookmark list. It 

th.erefore should be short -- less than 64 characters is strongly recommended. 

Examples of TITLE 

Some appropriate titles might be: 

<TITLE> Page Title <!TITLE> 

OR 

<TITLE>lntroduction to MIME types <!TITLE> 

This wi ll place the text "Testing Titles" in the Title space on your HTML 

browser. 

</html> 

Body 

The main content of your document begins with the <BODY> tag and ends with the 

</BODY> tag . Information such as document background colors and background 

patterns can also be assigned within the </BODY> tag. The </BODY> tag appears next­

to-last just prior to the </HTML> tag. 

PARAGRAPHS AND BREAKS 

When a browser reads the text in the html documents, it ignores al spaces, tabs and 

enter key, heading will be placed on a separate line .But if we wants to break blocks of 

text into paragraphs or even just start a new line, and we have to use one of these three 

tags 
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1. BREAK<BR> 

This is a line break and marks the starts of a new line. <BR> stands alone there is 

no clos ing tag. 

2. PARAGRAPHY<P> 

This marks the stat of a new paragraph and places a blank line before it. We can 

equally well place it at the end of a piece of text, at the start of a next. <P> is the second 

alone tag means it do not have closing tag. 

3. HORIZONTAL RULE<HR> 

This is the third tag which has no closing tag. It is used to draw a horizontal line to 

separate paragraphs. 

HEADING TAGS 

page. 

There are six heading tags that are usually used to separate sections of text on a 

<h1>this is the Largest Text</h1> 

<h2>this is the Next Size ... Header 2</h2> 

<h3>this is the same size as Normal Bold Text</h3> 

<h4>Smaller ... and Smaller ... H4</h4> 

<hS>Second Smallest</h6> 

<h6>this is the Smallest Header<h6> 

ALLIGNMENT 

Body text and headings are normally aligned to the left edge, but both can be in 

the center or in the right, if required . Following tag are used to align the text and 

pictures. 

Centering Text: 
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Want centered with simple <CENTEr..~ i~d </CENTER> commands. Here's what it 

looks like: 

<CENTER> 

All text in here will be centered 

</CENTER> 

Text to the Right: 

TEXT CAN BE FORMATE AT THE RIGHT SIDE. 

FORMATE IS: 

<P ALlGN="right">Text in here is pushed to the right</P> 

Text to the LEFT: 

TEXT CAN BE FORMATE AT THE left side 

FORMATE IS: 

<P ALlGN=" left">Text in here is pushed to the right</P> 

COLORS 

Normally the text appears in black color .By using color text we can change the 

color of text as well as background color of documents. To change the background 

color of a document the tags are: 
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<Body bgcolor=" red" > 

The color of text is change by using 

< Body text="pink"> 

Or we can also change text color in th is way: 

<Font color=" pink"> 

• Creating A Hypertext Link 

• 

CREATING A LINK TO YAHOO PAGE: 

<A HREF= .. http://www.yahoo.com.com .. >Click Here For yahoo<fA> 

• A stands for Anchor. It begins the link to another page. 

• HREF stands for Hypertext Reference. That's a nice, short way of 

saying to the browser, "This is where the link is going to go. " 

• http://www.yahoo.com is the FULL ADDRESS of the link. Also 

notice that the address has an equal sign in front of it and is enclosed 

in quotes. Why? Because it's an attri bute of the Anchor fl ag, a 

command inside of a command . 

• Where it reads "Click Here for yahoo" is where you write the text you 

want to appear on the page. What is in that space will appear on the 

page for the viewer to click. So, write something that denotes the link. 

fA ends the entire link command . 

• Link colors: 

Links are normally displayed in blue, if they have not yet been used, or deep 

purple if they have. if we change the color of our background, or of your text, the 

links may not stand out as well as we would like. 
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<BODY ... LlNK=value ALlNK=value VLlNK=value> 

any of all these options can be used to set the color of the text that leads to: 

An unvisited link (LINK), 

The active link (ALINK) 

A visited link (VLlNK), 

Placing an Image 

Here's the format for placing an image: 

<IMG SRC=limage.gif"> 

• IMG stands for "image." It announces to the browser that an image wi ll 

go here on the p ge. Yes, th image wi ll pop up right where you write 

in the image flag . 

• SRC stands for "source. " This again is an attribute , a command inside 

a command. It's telling the browser where to go to find the image. 

Again, it's best for you to place the images you want to use in the same 

directory as the page. This way you can call for the image by name 

alone. If you start to place your images all over the place, you'll have to 

start adding directories and sub-directories to the SRC attribute. And at 

this point, that is way too confusing . Just place the image in the same 

place as the HTML document that will call for it and then call for the 

image by name alone. You can get fancy later. Right now, let's just get 

it to work. 

• Image.gif is the name of the image. Notice it's following the same type 

of format as your HTML documents. There is a name (image) then a 

dot and then there is a suffix (gif) . 
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Image Formats: 

There are three basic formats you wi ll find on the World Wide Web. Each is 

denoted to the browser by a different suffix 

• .gif: This is an acronym for Graphics Interchange Format The format was 

invented by CompuServe and it's very popular. The reason is that it's a 

simple format. It's a series of colored picture elements, or dots, known as 

pixels, that line up to make a picture. Your te levision's picture is created 

much the same way. Browsers can handle this format quite easily. 

• .jpeg or .jpg (pronounced ''j-peg") there are two names to denote this 

format because of the PC and MAC formats allowing 3 and 4 letters after 

the dot. JPEG is an acronym for Joint Photographic Experts Group, the 

organization that invented the format. 

The format is unique in that it uses compression after it's been created. 

That's fancy computer talk that means that when the computer is not using 

a .jpeg image it folds it up and puts it away. For example, if the picture is 

10K bytes when displayed, it may be only 4K bytes when stored. It saves 

on hard drive space, but also tends to require a bit of memory on your part 

to unfold the image . 

. gif images also use compression. Yes, they do, but only when they are 

first created into that format. After that, no compression. JPEG, on the 

other hand, uses compression throughout its life to fold up smaller than it 

really is. 

• .bmp (pronounced "bimp") this is a "bitmap." You will probably never place 

a bitmap as an image, although now Internet Explorer browsers allow it. A 

bitmap is an image that a computer produces and places for you. Even 

though Internet Explorer will allow you to place an image as a BMP. No 

other browsers will be able to display it. Go with .gif or JPEG. 
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• Activating an Image: 

Here's the format: 

<A HREF= .. http://www.yahoo.com .. ><IMG SRC="homepage. if'></A> 

I placed an image flag where I would normally have placed words. Here's what 

you get with that format. Lay your pointer on the image, but don't click. You'll see the 

entire image is active: 

• Changing Image Size 

Every image is made up of pixels. The more pixels per inch the image have 

the better, and more detailed , the image will appear. Of course, that also means the 

image will take up a whole lot more bytes on your hard drive. You're going to find 

that most images on the Web are 72 and 100 pixels per inch. Yes, there are other 

settings, but 72-100 is a good trade-off between loss of detail and bytes required . 

Okay, so every image is made of pixels. This means that you can also denote 

an image by number of pixels. For example, the "sally.gif' image is 97 pixels high by 

64 pixels wide. 

Here's the coding : 

<IMG HEIGHT="##" WIDTH="##" SRC="image.gif"> 

• Border around the image 

That's what happens when you activate an image. It attempts to turn blue, or 

whatever color the page is set to, like the wording it's replacing, so it places what's 

known as a "border" around the image 

To make the border disappear, you again turn to a trusty attribute, a command 

inside of a command. 
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Here's the format: 

<IMG BORDER="Q" SRC="homepage.gif"> 

. Note that the number 0 is in quotes. It is an attribute. Again , lay your pointer on the 

image without clicking. You'll see that it is active but doesn't carry that annoying blue 

border. 

• BACKGROUND IMAGES 

We can also use image as a background to our page. This is not necessary to 

use large image as a background .HTML automatically repeats any image used 

as a background; so we can get a full screen from the tiniest images. 

EXAMPLE 

<HTML> 

<HEAD> 

<TITLE>BACKGROUN D</TITLE> 

</HEAD> 

<BODY BACKGROUND="MAP.JPG"> 

</BODY> 

</HTML> 

Lists 

There are several kinds of lists. Three important ones are 
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1. Ordered. 

2. Unordered . 

3. Definition. 

An ordered list has numbered items. 0 make the above list: 

<01> 

<Ii> Ordered. 

<Ii> Unordered. 

<Ii> Definition. 

<101> 

To make it without numbered items: 

• Ordered. 

• Unordered. 

• Definition. 

A definition list looks like this: 

Ordered Lists. 

The list items are ordered, e.g. by numerals. 

Unordered Lists. 

The list items aren't ordered particularly. 

Definition Lists. 

The list items have two parts: a title DT and a description DD. 

TABLE 

• <TABLE>This tag is use to start table. 

• <CAPT ION> and </CAPTION> places a caption over your table. The caption 

wi ll be bolded and centered. 

• <TR> is used when you want a new Table Row to begin. 

Notice that you need to end every table row with an <ITR>. 
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• <TO> denotes Table Data. You put this in front of every piece of information 

you want in a cell. 

You need to end every one that you open with an </TO>. 

• <IT ABLE> ends the whole deal. 

BORDER 

This tell the table how large the border should be. This is all relative in terms of 

pixels. Three is larger than two and two is larger than one, etc. Try different numbers. I 

happen to like the look of BORDER=3. BORDER=O gets rid of the borders altogether. 

• CELLSPACING 

It gives the amount of space between cells. I'd keep this kind of sma ll. Large spacing 

tends to defeat the purpose. 

• CELLPADDING 

It gives the amount of space (0 paddi g) between the cell borde and he cell 

contents . Note the cell border walls tend to fill out. A higher number fi lls out more. Try a 

few different settings. Sometimes bigger is better. 

The COLSPAN and ROWSPAN Attributes to TD and TH 

By default, a cell lies in a given row and column (depending on how you created 

the table). Sometime, however, you want a cell to "drop down" to the next cell below it, 

or perhaps stretch across into the next row. This is accompl ished using the COLSPAN 

and ROWSPAN attributes, respectively. COLSPAN indicates how many columns 

(counting to the right) are occupied by the cell, while ROWSPAN indicated how many 

rows (hanging down) the cell "spans". 
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Recall that, when you create a TR row, you must make sure that the number or 

cells in the columns in the row sum to the correct number (determined by the very first 

row) . In doing so, you must take into account the cells that span across multiple 

columns (COLSPAN) or hang down from a previous row (ROWSPAN). This is illustrated 

in the following example. 

<TABLE BORDER WIOTH=40%> 

<TR> <TO> 1.1 <TO> 1.2 <TO> 1.3 <TO> 1.4 <rrR> 

<TR> <TO> 2. 1 <TO COLSPAN=2> 2.2 <TO> 2.4 <rrR> 

<TR> <TO> 3.1 <TO> 3.2 

<TR> <TO> 4.1 <TO> 4.2 

<TR> <TO> 5.1 <TO> 5.2 

<rrABLE> 

<TO ROWSPAN=3> 3.3 <TO> 3.4 <rrR> 

<TO> 4.4 <rrR> 

<TO> 5.4 <rrR> 

The above table is d isplayed as: 

I I 

12.1-- li.2 12.4-

F - r2- f3.4 
.-

F - 14.2 3.3 14.4 

[5. 1 p- 15.4 

INTRODUCTION TO FORMS 

An HTML form is a section of a document containing normal content, markup, 

special elements called "controls" (checkboxes, radio buttons, menus, etc.), and labels 

on those controls. Users generally "complete" a form by modifying its controls (entering 
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text, selecting menu items, etc. }, before submitting the form to an agent for processing 

(e.g., to a Web server, to a mail server, etc. ) 

Here's a simple form that includes labels, radio buttons, and push buttons (reset 

the form or submit it): 

<FORM action=''http: //somesite.com/prog/adduser'' method="post"> 

<P> 

<LABEL for="firstname">First name: </LABEL> 

<INPUT type="text" id="firstname"><BR> 

<LABEL for="lastname">Last name: </LABEL> 

<INPUT type="text" id="lastname"><BR> 

<LABEL for= .. email .. >email: </LABEL> 

<INPUT type="text" id="email"><BR> 

<INPUT type="radio" name="sex" value="Male"> Male<BR> 

<INPUT type="radio" name="sex" value="Female"> Female<BR> 

<INPUT type="submit" value="Send"> <INPUT type="reset"> 

</P> 

</FORM> 

Control types 

HTML defines the following control types: 

BUTTONS 

Authors may create three types of buttons: 

• submit buttons: When activated, a submit button submits a form. 

A form may contain more than one submit button. 

57 



• 

• 

CHECKBOXES 

reset buttons: When activated, a reset button resets all controls 

to their initial values . 

push buttons: Push buttons have no default behavior. Each 

push button may have client-side scripts associated with the 

element's event attributes. When an event occurs (e.g., the user 

presses the button, releases it , etc. ), the associated script is 

triggered . 

Checkboxes (and radio buttons) are on/off switches that may be toggled by the 

user. A switch is "on" when the control element's checked attribute is set. When a 

form is submitted, only "on" checkbox controls can become successful. 

Several checkboxes in a form may share the same control name. Thus, for 

example, checkboxes allow users to select several values for the same property. 

The INPUT element is used to create a checkbox control 

Here are a few checkboxes: 

r r r r 

THE RADIO BUTTON 

This is a neat little deal that places a circle on the page. That circle is active and 

a reader can use the mouse to click on it. When the radio button is chosen, it darkens. 

Here are three radio buttons: 

r r r 

The point is that radio buttons are a one choice deal only. When you use radio 

buttons, only one can be checked. When an other is checked, the first one gives up its 

selection. 

Here's the command to place a radio button on your page. 

<INPUT TYPE="radio" NAME="heading of button" VALUE="button name"> 
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THE POP-UP BOX 

. This one is for people to choose their favorite color: 

I Blue :o:J 

Here are the commands that placed the Pop-Up box on the page: 

• SELECT 

<SELECT NAME="Favorite Color" SIZE="1 "> 

<OPTION SELECTED>8Iue 

<OPTION>Red 

<OPTION>Yeliow 

<OPTION>Green 

<OPTION>Black 

<OPTION>Orange 

<OPT ION>Purple 

</SELECT> 

Tells the computer another form is going here. This time it's a SELECT or Pop-Up 

form. 

• NAME: Same as above. This is the heading of the form item. It denotes how the 

results of the reader will arrive at your e-mail box. In this case it will say; "Favorite 

Color=" and then the reader's choice. 
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• SIZE denotes the size of the box. Here, 1 means one line or item is shown. Try 

putting two there if you'd like to see what it does. I prefer just one. More than one 

item tends to defeat the purpose of the Pop-Up Box. 

• OPTION SELECTED denotes which option will appear in the box. Note on the 

page that "Blue" is visible. 

• OPTION denotes another choice that will be visible when you click on the item. 

• SELECT finishes off the entire deal 
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Flash 

CHAPTER , 

Flash movies are graphics and animation for Web sites. They consist primari ly of 

vector graphics, but they can also contain imported bitmap graph ics and sounds . Flash 

movies can incorporate interactivity to permit input from viewers, and you can create 

nonlinear movies that can interact with other Web applications. Web designers use Flash to 

create navigation controls , animated logos, long-form animations with synchronized sound, 

and even complete, sensory-rich Web sites. Flash movies are compact, vector graphics, so 

they download rapidly and sca le to the viewer's screen size . 

The Flash work environment 

When creating and ed iting movies, you typically work with these key features : 

The Stage, the rectangular area where the movie plays 

The Timeline, where graphics are an imated over time 

Symbo ls, the reusable media assets of a movie 

The Library window, where symbols are organized 

The Movie Exp lorer, which gives an overview of a movie and its structure 

Floating, lockable panels, which enable you to modify various elements in 

the movie and configure the Flash authoring environment to best su it your 

workflow 
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The Stage and the Timeline 

Like fi lms, Flash movies divide lengths of time into frames . The Stage is where you 

compose the content for individual frames in the movie, drawing artwork on it directly or 

arrang ing imported artwork . The Stage is where you compose individual frames in a movie. 

The Timeline is where you coordinate the timing of the animation and assemble 

the artwork on separate layers . The Timeline displays each frame in the movie. 

Creating a new movie and setting its properties 

Each time you open Flash, the application creates a new file , with the FLA 

extension . You can create additiona l new movies as you work. To set the size, 

frame rate, background color, and other properties of a new movie, you use the 

Movie Properties dialog box. 

To create a new movie and set its properties: 

1. Choose Fi le> New. 

2. Choose Modify> Movie. The Movie Properties dialog box appears. Or press Ctrl + m 

3. For Dimens ions, To specify the Stage size in pixels, enter values for Width and 

Height. The 

4. defau lt movie size is 550 x 400 pixels . The minimum size is 18 pixels by 18 

5. pixels; the maximum is 2880 x 2880 pixels. 
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6. To set the background co lor of your movie, choose a co lor from the 

7. Background co lor swatch. 

8. Click OK. 

Creating animation 

You create animation by changing the content of successive frames. You can 

make an object move across the Stage, increase or decrease its size, rotate, 

change co lor, fade in or out, or change shape. Changes can occur independently 

of, or in concert with , other changes . For example, you can make an object rotate 

and fade in as it moves across the Stage . 

There are two methods for creating an animation sequence in Flash: 

Frame-by-frame animation and tweened animation. In frame-by-frame animation 

You create the image in every frame . In tweened animation, you create starting 

And ending frames and let Flash create the frames in between . Flash varies the 

Object's size, r tati n, I r, r th r attri te evenly etween the starting and 

End ing frames to create the appearance of movement. 

Tweened animation is an effective way to create movement and changes over 

Time whi le minimizing fi le size. In tweened animation , Flash stores on ly the va lues 

For the changes between frames. In frame-by-frame animation , Flash stores the 

Values for each complete frame. 

Representations of animations in the Timeline 

Flash distinguishes tweened an imation from frame-by-frame an imation in the 

Timeline as follows : 
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Motion-tweened key frames are indicated by a black dot and intermediate 

Tweened frames have a black arrow with a light blue background. 

Shape-tweened key frames are indicated by a black dot and intermediate 

Frames have a black arrow with a light green background. 

~) IU 
A dashed line indicates that the final key frame is missing. 

~ ------------------ J 
About layers in animation 

Each scene in a Flash movie can consist of any number of layers. As you animate, 

You use layers to organize the components of an animation sequence and to 

Separate an imated objects so they don't erase, connect, or segment each other. If 

You want Flash to tween the movement of several groups or symbols at once, 

Each must be on a separate layer. Typically, the background layer contains static 

Artwor . Additional layers contain one separate animated object each. 
I I I I I I t I I. , I I I I I I I I I I I I I I , I 

1 5 10 15 20 25 , 

• 
~ ) 

Creating frame-by-frame animations 

Frame-by-frame animation changes the contents of the Stage in every frame and 

is best suited to complex animation in which an image changes in every frame 

instead of simply moving. Frame-by-frame animation increases file size more 
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rapid ly than tweened an imation . Use frame-by-frame animation when you need to change an 

image in each frame. 

To create frame-by-frame animation: 

1. Click a layer name to make it the current layer, and select a frame in th e 

Layer where you want the animation to start. 

2. If the frame isn't already a key frame, choose Insert > Key frame to make it 

One. 

3. Create the image for the first frame of the sequence. 

4. You can use the drawing tools, paste graphics from the Clipboard, or import 

A fi le. 

5. Click the next frame to the right in the same row and choose Insert> 

Key frame or right-c!ick (Windows) or Control-click (Macintosh) and choose 

Insert Key frame from the Frame pop-up menu. 

6. This adds a new key frame whose contents are the same as those of the first 

Key frame . 

7. Alter the contents of this frame on the Stage to develop the next increment 

Of the an imation . 

8. To complete your frame-by-frame animation seq uence, repeat steps 4 and 5 

Until you have built the motion you want. 

9. To test the animation sequence, choose Control> Play or click the Play 

Button on the Controller. 
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It can be useful to play back animation as you create it. 

Using layers 

Layers are like transparent sheets of acetate stacked on top of each other. When you create 

a new Flash movie, it contains one layer. You can add more layers to organize the artwork, 

animation, and other elements in your movie. You can draw and edit objects on one layer 

without affecting objects on another layer. Where there is nothing on a layer, you can see 

through it to the layers below. The number of layers you can create is limited only by your 

computer's memory, and layers do not increase the file size of your published movie . You 

can hide layers, lock layers, or display layer contents as outlines. You can also change the 

order of layers. 

Creating layers 

When you create a new layer, it appears above the selected layer. A newly added 

laye becomes the active laye . 

To create a layer, do one of the fo llowing: 

Click the Add Layer button at the bottom of the Timeline. 

Choose Insert > Layer. 

Right-click (Windows) or Control-click (Macintosh) on a layer name in the 

Time line and choose Insert Layer from the context menu. 

Viewing layers 
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As you work, you may want to show or hide layers. A red X next to a layer's name 

indicates that the layer is hidden. Hidden layers are preserved when a movie is 

published. However, you cannot edit the hidden layers in the SWF file if you open 

the SWF file in Flash. 

SHOW OR HIDE THE LAYER 

To show or hide a layer, do one of the following: 

Click in the Eye column to the right of the layer's name to hide that layer. 

Click in it again to show the layer. 

Click the eye icon to hide all the layers. Click it again to show all layers. 

Drag through the Eye column to show or hide multiple layers. 

Alt-click (Windows) or Option-click (Macintosh) in the Eye column to the right 

of a layer's name to hide all other layers. Alt-click or Option-click it again to 

show all layers. 

To view the content of a layer as outlines, do one of the fol lowing: 

Click in the Outline column to the right of the layer's name to display all 

objects on that layer as outlines. Click in it again to turn off outline display. 

Click the outline icon to display objects on all layers as outlines. Click it 

again to turn off outline display on al l layers. 
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Alt-click (Windows) or Option-click (Macintosh) in the Outline column to the 

right of a layer's name to display objects on all other layers as outlines. 

Alt-cl ick or Option-click in it aga in to turn off outli ne display fo r all layers. 

To change a layer's outline color: 

2 

3 

r5~;;;;:;---::-~~;:::iit-- Hiddtm layer 

Do one of the following : 

Objects on layer 
dISp l <ly~d as Olltlin f:' ::i 

Active layer 

Locked layer 

Double-click th e layer' s icon (the icon to the left of the layer name) in the 

Timeline. 

Right-click(Windows) or Control-click (Macintosh) the layer name and 

choose Properties from the context menu. 

Select the layer in the Timeline and choose Mod ify> Layer. 

In the Layer Properties dialog box, click the Outline Color co lor box and 

select a new color, enter the hexadecimal va lue for a color, or click the Color 

Picker button and choose a co lor. 

Click OK. 
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Editing layers 

To draw, paint, or otherwise modify a layer, you select the layer to make it active. 

A pencil icon next to a layer's name indicates that the layer is active . Only one 

layer can be active at one time (although more than one layer can be selected at 

one time). You can rename, copy, and delete layers. You can lock layers to 

prevent them from being edited, and you can change the order of layers. 

By default, new layers are named by the order in which they are created: Layer 1, 

Layer 2, and so on. You can rename layers to better reflect their contents 

To select a layer, do one of the following: 

Click the layer's name in the Timeline. 

Click a frame in the Time line of the layer you want to select. 

Select an object on the Stage that is located on the layer you want to select.. 

To rename a layer, do one of the following: 

Double~click the layer name and enter a new name. 

Select the layer in the Timeline and choose Modify> Layer. In the Layer 

Properties dialog box, enter the new name in the Name text box and click 

OK. 

To copy a layer: 

1 

Click the layer name to select the entire layer. 
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2 

Choose Edit> Copy Frames. 

3 

Click the Add Layer button to create a new layer. 

4 

Click the new layer and choose Edit> Paste Frames. 

To delete a layer: 

1 

Select the layer. 

2 

Do one of the fol lowing : 

Click the Delete Layer button in the Timeline . 

Drag the layer to the Delete Layer button. 

To change the order of layers: 

Drag one or more layers in the Timeline. 

Using mask layers 

For spotlight effects and transitions, you can use a mask layer to create a hole 

through which the contents of one or more underlying layers are visib le. You can 

group multiple layers together under a single mask layer to create sophisticated 

effects. You can also use any type of animation, except motion paths, to make the 

70 



mask move . You cannot mask layers inside of buttons. 

To create a mask layer: 

1 

2 

3 

4 

Select or create a layer containing the content that will be vis ible through the 

holes in the mask. 

With the layer selected, choose Insert> Layer to create a new layer above 

it. 

A mask layer always masks the layer immediately below it, so be sure to 

create the mask layer in the proper place. 

Draw a filled shape, place type, or create an instance of a symbol on the 

mask layer. Flash ignores bitmaps, gradients, transparency, colors, and line 

styles in a mask layer. Any filled area will be completely transparent in the 

mask; any nonfi lled area will be opaque. 

Right-click (Windows) or Control-click (Macintosh) the mask layer's name in 

the Timeline and choose Mask from the context menu. 

The layer is converted to a mask layer, indicated by a down arrow icon. The 

layer immediately below it is linked to the mask layer, and its contents show 

through the filled area on the mask. The masked layer name is indented, 

and its icon changes to a right-pointing arrow. 

To display the mask effect in Flash, lock the mask layer and the masked 

layer. 

71 



Previewing movies in the authoring 

environment 

To preview movies, you use commands in the Control menu, buttons on the 

Controller, or keyboard commands. 

To preview the current scene , do one of the fo llowing: 

Choose Control> Play. 

Choose Window> Toolbars > Controller (Windows) or Window> Controller 

(Macintosh) and click Play. 

Press Enter (Windows) or Return (Macintosh). The animation sequence 

plays in the Movie window at the frame rate you specified for the movie. 

To step through the frames of the animation, use the Step Forward and Step 

Backward buttons on the Controller, or choose those commands from the 

Control menu. You can also press the < and> keys on the keyboard. To go 

to the first or last frame in a movie, use the First Frame or Last Frame 

button on the Controller. 

Saving movie files 

You can save a Flash FLA movie file using its current name and location, or save 

the document using a different name or location . You can revert to the last saved 

version of a file. 
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To save a document: 

1 

2 

3 

Do one of the following : 

To overwrite the current version on the disk, choose File> Save. 

To save the file in a different location or with a different name, choose File> 

Save As. 

If you choose the Save As command, or if the file has never been saved 

before, enter the file name and location. 

Click Save. 

orking wit color 

Flash provides a variety of ways to apply, create, and modify colors. Using the 

default palette or a palette you create, you can choose colors to apply to an 

object's stroke or fill. Applying a stroke color to a shape paints the outline of the 

shape with that color. Applying a fill color to a shape paints the interior space of 

the shape with that color. 
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Using the Stroke and Fill controls in the toolbox 

To select a solid stroke color or a solid or gradient fill co lor, switch the stroke and 

fill colors, or select the default stroke and fill colors (black stroke and white fill), 

you can use the Stroke and Fill controls in the toolbox. 

The toolbox Stroke and Fi ll contro ls set the painting attributes of new objects you 

create with the drawing and painting tools. To use the Stroke and Fill controls to 

change the painting attributes of existing objects, you must first select the objects. 

CoIofs 

# P. 
I ~ ~ 
"11211.2: 

To apply stroke and fill colors using the toolbox con rols, do one of he 

following: 

Click the triangle next to the Stroke or Fill color box and choose a color 

swatch from the pop-up window. Gradients can be selected for fill color only. 

Type a color's hexadecimal value in the text box in the color pop-up window. 

Click the None button in the color pop-up window to apply a transparent 

stroke or fill. 

Buttons are actually four-frame interactive movie clips. When you select the button 

behavior for a symbol, Flash creates a Timeline with four frames. The first three 

frames display the button's three possible states; the fourth frame defines the 
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active area of the button. The Timeline doesn't actually play; it simply reacts to 

pointer movement and actions by jumping to the appropriate frame. 

Each frame in the Timeline of a button symbol has a specific function: 

The first frame is the Up state, representing the button whenever the pointer is not 

over the button. 

The second frame is the Over state, representing the button's appearance when the 

pointer is over it. 

The third frame is the Down state, representing the button's appearance as it is 

clicked. 

The fourth frame is the Hit state, defining the area that will respond to the mouse 

click. This area is invisible in the movie. 

To create a button: 

1 

Choose Edit> Deselect All to ensure that nothing is selected on the Stage. 

2 

Choose Insert> New Symbol, or press Control+F8 (Windows) or Command+F8 

(Macintosh) . 

To create the button, you convert the button frames to keyframes. 

3 

In the Symbol Properties dialog box, enter a name for the new button symbol, and 

for Behavior choose Button. 
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Flash switches to symbol-editing mode. The Timeline header changes to display 

four consecutive frames labeled Up, 

Over, Down, and Hit. The first frame, Up, is a blank keyframe. 

~Flash 5 - (arUla:l) RIilf3 

D 5 fiiD ~ [9. db ~ ~ I(") C" fjiJ. +~ +( "b 

~ ~~alxU ~~J 

1100% 
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To create the Up state button image, use the drawing tools, import a graphic, or 

place an instance of another symbol on 

the Stage. 

You can use a graphic or movie clip symbol in a button, but you cannot use another 

button in a button. Use a movie clip 

symbol if you want the button to be animated. 

5 

Click the second frame, labeled Over, and choose Insert> Keyframe. 
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Get URL 

Syntax 

getURL(url [. window [. variables]]); 

Arguments 

uri The URL from which to obtain the document. The URL must be in the same 

sub domain as the URL where the movie currently resides. 

window An optional argument specifying the window or HTML frame that the 

document should be loaded into. Enter the name of a specific window or choose 

from the following reserved target names: 

_self specifies the current frame in the current window. 

_blank specifies a new window. 

_parent specifies the parent of the current frame. 

_top specifies the top-level frame in the current window. 

variables An optional argument specifying a method for sending variables. If 

there are no variables, omit this argument; otherwise, specify whether to load 
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variab les using a GET or POST method. GET appends the variables to the end of the 

URL, and is used for small numbers of variables. POST sends the variables in 

a separate HTTP header and is used for long strings of variables . 

Description 

Action; loads a document from a specific URL into a window, or passes variables to another 

application at a defined URL. To test this action, make sure the file to be loaded is at the 

specified location. To use an absolute URL (for example, http://www.myserver.com). you 

need a network connection. 

79 



ASP 

Active Server Pages (ASP) solves all the problems associated with CGI and server 

APls. In addition to being just as efficient as ISAPI applications , ASP is a lot more simple to 

learn and much easier to use. 

With ASP, you simply write your code in the HTML page itself. The HTML tags and the 

code are side by side. You write the code in a simple scripting language that is easy to learn 

and easy to use. Then you save the page to your Web site and it's ready to go. No compiling 

and no complex interfacing! 

As you can imagine, ASP makes it much quicker and easier to create highly interactive 

Web sites. It also makes your pages easier to maintain and update in the future. 

What is ASP? 

• ASP stands for Active Server Pages 

• ASP is a Microsoft technology 

• ASP allows you to display dynamic information 

• ASP is a program that runs inside liS or PWS 

• liS stands for Internet Information Services 

• PWS stands for Personal Web Server 

• An ASP file has the file extension ".asp" 

What Can You Do with Active Server Pages? 

There are many things you can do with Active Server Pages. 

• You can display date, time, and other information in different ways. 

• You can make a survey form and ask people who visit your site to fill it out, send emails, 

save the information to a file, etc 
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ASP Compatibility 

• ASP is a Microsoft Technology 

• To run liS you must have Windows NT 4.0 or later 

• To run PWS you must have Windows 95 or later 

• ChiliASP is a technology that runs ASP without Windows as 
• Instant ASP is another technology that runs ASP without Windows 

What is an ASP File? 

1. An ASP file is just the same as an HTML file 

2. An ASP fi le can contain text, HTML, XML, and scripts 

3. Scripts in an ASP file are executed on the server 

4. An ASP file has the file extension ".asp" 

What can ASP do for you? 

• Dynamically edit, change or add any content of a Web page 

• Respond to user queries or data submitted from HTML forms 

• Access any data or databases and return the results to a browser 

• Customize a Web page to make it more useful for individual users 

• The advantages of using ASP instead of CGI and Perl, are those of simplicity and 

speed 

• Provides security since your ASP code can not be viewed from the browser 

• Since ASP files are returned as plain HTML, they can be viewed in any browser 

• Clever ASP programming can minimize the network traffic 
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How to Run ASP on your own PC 

• To run liS you must have Windows NT 4.0 or later 

• To run PWS you must have Windows 9S or later 

• Save ASP files in the web folder (usually C:\lnetpub\wwwroot) 

• Or save ASP files in the virtual web directory 

ASP pages will not display properly until published 

How to install PWS and run ASP on Windows 98 

1. Open the Add-ons folder on your Windows98 CO, find the PWS folder and run the 

setup.exe file . 

2. An Inetpub folder will be created on your harddrive. Open it and find the wwwroot 

folder. 

3. Create a new folder, like IMyWeb", under wwwroot. 

4. Use a te t dit r to write some A P c e, \Ie the file as Itest1.asp" in the IMyWeb" 

folder. 

S. Make sure your Web server is running - The installation program has added a new icon 

on your task bar (this is the PWS symbol). Click on the icon and press the Start button 

in the window that appears. 

6. Open your browser and type in Ihttp://localhostiMyWeb/test1.asp", to view your first 

ASP page. 

How to install liS and run ASP on Windows 2000 

1. From your Start Button, go to Settings, and Control Panel 

2. In the Control Panel window select Add/~emove Programs 

3. In the Add/Remove window select Add/Remove Windows Components 

4. In the Wizard window check Internet Information Services, click OK 

S. An Inetpub folder will be created on your harddrive 
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6. Open the Inetpub folder, and find a folder named wwwroot 

7. Create a new folder, like "MyWeb", under wwwroot. 

8. Use a text editor to write some ASP code , save the fi le as "test1 .asp" in the "MyWeb" 

folder 

9. Make sure your Web server is running - The installation program has added a new icon 

on your task bar (this is the liS symbol). Click on the icon and press the Start button in 

the window that appears. 

10.0pen your browser and type in ''http://localhostlMyWeb/test1.asp'', to view your first 

ASP page 

How to install 115 and run ASP on Windows XP 

Professional 

Note: You cannot run ASP on Windows XP Home Ed ition . 

1. Insert the Windows XP Professional CD-Rom into your CD-Rom Drive 

2. Fro you Sta Button, go to Settings, and Control anel 

3. In the Control Panel window select Add/Remove Programs 

4. In the Add/Remove window select Add/Remove Windows Components 

5. In the Wizard window check Internet Information Services, click OK 

6. An Inetpub folder will be created on your harddrive 

7. Open the Inetpub folder, and find a folder named wwwroot 

8. Create a new folder, like "MyWeb", under wwwroot. 

9. Use a text editor to write some ASP code, save the file as "test1.asp" in the "MyWeb" 

folder 

10.Make sure your Web server is running - The installation program has added a new icon 

on your task bar (this is the liS symbol). Click on the icon and press the Start button in 

the window that appears. 

11.0pen your browser and type in ''http://localhostlMyWeb/test1.asp'', to view your first 

ASP page 
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Procedures 

The ASP source code can contain procedures and functions: 

<html> 

<head> 

<% 

sub vbproc(num1 ,num2) 

response.write(num1 *num2) 

end sub 

%> 

</head> 

<body> 

<p>Result: <%call vbproc(3,4)%></p> 

</body> 

</html> J 
'-----------------

Insert the <%@ language="language" %> line above the <html> tag to write procedures or 

functions in another scripting language than default: 

<%@ language="javascript" %> 

<html> 

<head> 

<% 

function jsproc(num1 ,num2) 

{ 

Response.Write(num1*num2) 

} 

%> 

</head> 
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<body> 

<p>Result: <%jsproc(3,4)%></p> 

</body> 

</html> 

The Basic Syntax Rule 

, An ASP file normally contains HTML tags, just like an HTML fi le, However, an ASP file can 

also contain server scripts, surrounded by the delimiters <% and %>, Server scripts are 

executed on the server, and can contain any expressions, statements, procedures, or 

operators valid for the scripting language you prefer to use. 

The Response Object 

The Write method of the ASP Response Object is used to send content to the browser. For 

example, he ollowing statement sends the text "Hello World" to the browser: 

<% 

response. write("Helio World!") 

%> 

VBScript 

You may use different scripting languages in ASP files. However, the default scripting 

language is VBScript: 

<html> 

<body> 

<% 
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response.write("Helio World!") 

%> 

</body> 

</html> 

The example above writes "Hello World!" into the body of the document. 

JavaScript 

To set JavaScript as the default scripting language for a particular page you must insert a 

language specification at the top of the page: 

<%@ language="javascript"%> 

<html> 

<body> 

<% 

Response.Write("Helio World!") 

%> 

</body> 

</html> 

HOW TO CREATE VIRTUAL DIRECTORY: 

• Open liS . 

• Open pc1. 

• Right click on Default web site. 

• Cl ick on Next. 
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• Now write ALIAS (any name for virtual directory). 

• Click on NEXT. 

• Now BROWSE the folder of data base files. 

• Click on ok. 

• Now virtual directory is created. 

Built-in ASP Objects 

The ASP framework gives the programmer the ability to write code to access objects. 

These objects can be created by the programmer. The programmer can also access any of the 

built in ASP objects. These objects were included in ASP to make certain tasks easier to 

accomplish. There are five built in objects that make up the core of the ASP object Model. 

· Application Object: The Application object is used to share information 

among all users of a given application. An application consists of all of the .asp files in a 

virtual directory and its sub directories. This is one way to create global variables . 

· Request Object: The Request object is used to gain access to any 

information that is passed with an HTTP request(HTML Form Parameters, 

cookies,client certificates, file uploads). 

· Response Object: The Response object is used to control the information 

you send to a user. (information sent to the browser, browser redirection, cookie va lues) 

· Server Object:The Server object provides access to methods and properties 

on the server. (Examples are server.createobject, server.mappath, server.htmlencode, 

se rver. urlencode) 

· Session Object:Like the application object, the Session object keeps 

information that is then made available to the who le application. The difference is that 
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all users share one Application object, while with Sessions there is one Session object 

for each user. The session object is often used to store user preferences. 

HTMLvs.ASP 

Firstly, while ASP is different from HTML, it is usually written as scripts within an HTML 

document. HTML is a static document that the Web server displays upon request by the 

browser. But if the HTML has ASP scripts embeded within it, the server will run those scripts 

and then display the resu lts within the page on the browser. 

ASP. vs.~avaScript 

So, it sounds like ASP is more like JavaScript than HTML. However, JavaScript is run in the 

Web browser itself rather than on the server side. This gives you all the processing power of 

the Web server to back up your scripts. Plus, because it is run separately from the browser, it 

can interact with other server-side technology such as databases, unlike JavaScript. 

.CGI 

In some ways, ASP and CGI are similar. You can use CGI to access databases and create 

dynamic, interactive, personalized pages. CGI programs run on the Web server rather than in 

the browser. But CGI uses an external program to do the work, which means that there is an 

additional layer on your Web server, which can cause more load and slow pages down. 

Example: Processing a form on the Web 

r HTML --I While you can create a form with HTML, you cannot process it using just HTML. 

JayaScript I JavaScript processes the form within the browser itself. It cannot do any 

interaction with non-browser objects, such as writing the data to a file . 

rr--Fopens a connection with another program on the Web server. The form data 
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r-==--=;'-ca~ --b'~ ~ani~~iat~d i ~ any-~ay ' that -~ou - c'an w;ite a' ~rogram to h~ndle . But' the : 

I server has to maintain both the connection and run the program itself. 

'~ ~SP ~lIo~s ~he se;;~r ~~ -~o t~e work ~f Pro~~S~i~9 the form. Th-~ 'A'SP direct'i~es -
I ; are included in the .asp file itself. 

- . ..•. -- .... -..... --- -, - .. ---, ---,-_ ... - - -_ ... _. -- . 

ASP is a powerful tool for Web developers. If you have access to an liS server or Chili!Soft 

ASP server you can make your sites dynamic, personalized, and interactive quickly and easily 

ASP FORMS 

User Input 

The Request object may be used to retrieve user information from forms: 

<f rm method="get" action="simpleform.asp" 

First Name: <input type="text" name="fname"> 

<br I> 

Last Name: <input type="text" name="lname"> 

<br I><br I> 

<input type="submit" value="Submit"> 

</form> 

User input can be retrieved in two ways: With Request.QueryString or Request.Form. 

Request.QueryString 

The Request.QueryString command is used to collect values in a form with method="get". 

Information sent from a form with the GET method is visible to everyone (it will be displayed in 

the browser's address bar) and has limits on the amount of information to send. 
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If a user typed "Bill" and "Gates" in the form example above , the URL sent to the server would 

look like this: 

jhttp://WWW.W3SChOols.com/si mpl eform.asp?fname=Bi 1I&lnamH=Gates 

Assume that the ASP fi le "simpleform.asp" contains the following script: 

<body> 

. Welcome 

<% 

response.write(request.querystring("fname")) 

response.write(" " & request.querystring("lname")) 

%> 

</body> 

The browser will display the following in the body of the document: 

jwelcome Bill Gates 

Request.Form 

The Request.Form command is used to collect values in a form with method="post" . 

Information sent from a form with the POST method is invisible to others and has no limits on 

the amount of information to send. 

If a user typed "Bill" and "Gates" in the form example above, the URL sent to the server would 

look like this: 

jhttp://WWW.W3SChOols.com/si mpleform.asp 

Assume that the ASP file "simpleform.asp" contains the following script: 
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<body> 

Welcome 

<% 

response. write( request. form("fname")) 

response.write(" II & requestform("lname")) 

%> 

</body> 

The browser will display the fo llowing in the body of the document: 

jwelcome Bill Gates 

Form Validation 

User input should be validated on the browser whenever possible (by client scripts). Browser 

validation is faster and you reduce the server load. 

You should consider using server validation if the user input will be inserted into a database. A 

good way to val idate a form on the server is to post the form to itself, instead of jumping to a 

different page. The user will then get the error messages on the same page as the form. This 

makes it easier to discover the error. 
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Dynamic HTML 

Dynamic HTML is a term used by some vendors to describe the 

combination of HTML, style sheets and scripts that allows documents to be 

animated ." DHTML is the combination of HTML and JavaScript DHTML is the 

combination of several bui lt-in browser features in fourth generation browsers 

that enab le a web page to be more dynamic 

Dynamic 
the abi lity of the browser to alter a web page's look and style after the 

document has loaded 

The Elements of DHTML 

HT 4 .0 

HTML 4.0 introduced two important th ings: Cascading Style Sheets 

(CSS), and the Document Object Model (DOM) . Creating dynamic HTML 

documents would not be possible without these two add itions. 

Cascading Style Sheets (CSS) 

With CSS we got a style and layout model for HTML documents. Creating 

dynamic HTML documents would not be possible without CSS. 

Document Object Model 

With the DOM we got a document content model for HTML documents. 

Creating dynamic HTML documents would not be possible without the DOM. 
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.JavaScript (and VBScript) 

With HTML 4.0, CSS and the DOM were made avai lable for scripting . 

Creating dynamic HTML document~ wou ld not be possible without the ability to 

change the style, layout and content of HTML document via scripts. 

The Bottom Line 

DHTML is the art of making HTML pages dynamic by using scripting to 

manipu late the style, layout and contents of the document. 

Position 

The position property gives us the opportunity to place the elements 

anywhere on the document. 

position:relative 

This property places the element based on (or relative to) its current 

position. 

HI 

position : relative; 

l eft:10 ; 

This places the header 10 pixels to the right from where it is normally placed . 

position: absolute 

This property places the element out from the window's marg ins. 
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Hl 

position:absolutei 

left:10; 

This places the header 10 pixels to the right from the left-margin. 

Z-index 

H1 

{ 

The z-index property determines the placement order of the elements. 

z-index:1 ; 

} 

H2 

{ 

z-index:2; 

} 

The H1 element is placed before the H2 element, so if these two elements 

happen to be placed on top of each other, the H2 element is placed on top of the 

H1 element. 
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Filters 

Internet Explorer 4.0 introduced the filter property to CSS. The filter 

property allows you to add more style effects to your text and images. 

H1 

{ 

width: 1 00%; 

filter:glow; 

} 

The element you want to add a filter to , must have a specified width. 

There are many values to the filter property, this example shows the "glow" 

value, which produces this output: 

\Header 
----------------------------------------------------~ 

All the values have arguments that allow you to control the filters. 

Filters 

Iprope~ Ivalue Isyntax Explanation 

alpha opacity filter:alpha(opacity=20, Allows you to set the 

fi ni shopacity finishopacity=100, style=1, opacity of the element 

style startx=O, 

startx starty=O, finishx=140, 

starty finishy=270) 

finishx 

finishy 

n add filter:blur(add=true, Makes the element 

direction directions=90, strength~80); blur 
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I 
~ 

Istrength 

throma
. 

leolor fil ter:chroma(color=#ffOOOO) Makes the specified 

color transparent 

fliph none fi lter:f1iph; Flips the element 

horizontally 

r
iPV Inone Ifi lterfliPV; Flips the element 

vertically 

glow color fi lter:glow(color=#ffOOOO, Makes the element 

strength strength=5) ; glow 

Igra
y Inone fi lter:gray; Renders the element 

in black and white 

invert none filter: inver; Renders the element 

in its reverse color 

and brightness values 

mask color fil ter:ma k( I r=#ffOOO ); Renders the element 

with the specified 

background color, and 

transparent 

foreground color 

shadow color 'filter:shadow(color=#ffOOOO, Renders the element 

direction direction=90); with a shadow 
~ 

dropshadow color fil ter:dropshadow( color=#ffOOOO, Renders the element 

offx offx=5, offy=5, positive=true) ; with a dropshadow 

offy 

positive 

wave add fi lter:wave(add=true, freq=1, Renders the element 

freq lightstrength=3, phase=O, like a wave 

Ii ghtstrength strength=5) 

phase 
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I 
Istrength 

I 
xray none filter:xray; Renders the element 

in black and white 

with reverse color and 

brightness values 

Note: Some of the Fi lter properties will not work unless the class, element, etc. 

states that the background-color is set to transparent. 

Background 

The background property allows you to select your own background, in any style. 

background-attachment:scroll 

The background scrolls along with the rest of the page. 

background-attachment:fixed 

The background does not move when the rest of the page is scrolling . 

Example 

document.writeO method of JavaScript to create Web Pages on the fly. 

<script> 

document.write("This is text created on the fly!") 

</script> 
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Basic syntax 

<layer>Text inside layer</layer> 

Layer attributes 

- - ... -- - ... - ----- .. - - '. .- .- ~-. ---- ---~--. . -~- .. - ---- .. --.---.-.. - .----- -
, Layer attributes 

'lid 'IThe na~~. ~fthe layer, .~se~ to" i~en~ify it in. yo~~ scrip~ . i 
f 

, ~ ._-. 

I~~_ft .... [~he .. p~~.i~~on __ ~~ : he ~a~~r in ~el"at"i_on~h~ t~" the ~,, ~~or~~a~~s 
! 

.. . " . . . , 

, ,Ito
p
"" 

- -- -

". l~he~ositi~I .. ~ ~f the .~aye~ in relationship t~ ~le y coord~ates 
-- .. .-. --

: I~~~t_h .... ~ ._.-.-
.. I~~e,,~! .. ~:h _of .. t~e l~~er,_~ ~x ~r .o/~" 

.-.~- --._.- _ .... . - .... .. .-- --~ ,,-

' I.~e~~ht 
- - "'- -

. IThe height of the lay~r, in px or_% 
"" 

'lbgCOlor IThe background color of the layer 
. - - - .. ... .. -- , ... 

Ib~~~~roun~ . IT~e back~ound ima .. ge .. ~~t~~ layer .. 
-... - - . . . .. .-

:Is_rc iThe external htrnl document contained inside the layer 
._." .. - "." .. -- - -_._-" -----_. --- - - "---------.. ---_._-_._- -._.- ~ ... . _-- - _ . 

Mix and match different attributes any way you like. Here's a samp le 

layer that uses some of the above attributes: 

<l ayer id="mylayer" width=100px height=70px 

bgColor="yellow"><h 3>A layer</h3>< /layer> 

Scripting layers: 

Its the scripts that make layers come alive. To access a layer, 

you need to use the following syntax: 

documenLiayername 

, 
f 

i 

, 

I 
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Once you've accessed a layer, you can then go on and manipulate one of the 

layer's attributes to produce dynamic effects. 

DHTML in IE 4 

DHTML in IE does not rely on anyone tag, but rather, new objects and 

properties that stem out of the usual HTML tags you 're used to working 

w ith, such as <div> and <table>. It's a lot more powerful, but at the same 

time, a nd lot more complicated to grasp. 

The style object of IE 4 

HTML elements in I E 4 now all support a style object, which is 

essentially the "dynamic" object used to manipulate th e look and "feel" 

of that element . Like th e < layer> tag, elements ca n also be ass igned 

an "id " attribute, which can then be used to identify it during scripting . 

For exampie: 

<div id="adiv">< /div> 

In your script, the syntax required to access the style object of "adiv" 

would look like this: adiv.style 

The style object contains many properties, and by manipulating these 

properties, you can alter the look of an element, dynamically. I'll show 

some of these properties now : 

1 --- .----~.--------.------------.-.-.-,-.-.-. - -~ - -----.----.---.... - ... ---.. - .. --- - --

, Important properties of the style object 

'lbaCkgroundColor IThe backgound color of the element 
Ib~Ck~:r~~ndi~age IThe 'ba~k~rouncl i;ag~~fth~--ele~;~t '--''''--'- -, -, 

I ~~~~~-, "- _,', '-. ~'-"" I~h~,~~l~_~fth~- e_~el~~~~ , ' , , .. q __ ,~ -~' _~_~_ 
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The position type of the element. Accepted values are "absolute" and 
, P_osition . 

relative" 
r-"-___ -'----' __ I -

Ip~xel':i~th _ \The width ofthe element 

l;-=p=ix-e-lH....:.e-'-i--"-g-ht=---'--J~he_ ~~iiht' ~~:he~l~~e~t _ 

\~ ixelL~ft - --

\ ~'i~eIToP . 

The position of the element in relation to the x coordinates 

The position of the element in relation to the y coordinates 

The properties above on ly represent a subset of the total supported properties, 

but are the most commonly used ones. The basic syntax to manipulating any 

style property is the same, which I'll show in a minute. By accessing these 

properties, we can change the look and style of most HTML elements (as 

opposed to just the <layer> tag in Netscape)! 

Dynamic content in NS 4 

Changing content in NS 4 involves the layer tag. All layers are 

treated by the NS browser as a separate entity from the rest of the 

page, with their own document object (which in turn contains other 

objects supported by document) 

<l ayer i d= " a l ayer " width=100 % h e ight=3 0>< /l aye r > 

Moving elements around in the 

document 

You can create content that fly all over the screen freely. In Netscape, 

t his is done by manipulating t he left and t op attributes of the < layer> tag. 

In IE 4 , the same th ing is accomplished by altering the pixelLeft and 

pixelTop properties of the style object. 
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Moving elements in NS 4 

layers support the left and top property, which controls its offset from 

the document's upper left corner. Well, by using simple math and a couple 

of lines of script, we can dynamically update these properties so the layer 

moves! 

Creating cross-browser DHTML 

cross-browser DHTML basically means using various scripting 

techniques you picked during those JavaScript years to sniff out which 

browser the user is using, and execute the code intended for that browser. 

Creating a "cross-browserWW layer 

NS that understands the <layer> tag, and IE that understands the <span> 

and <div>'. If we wanted to create a simple DHTML effect such as a moving 

image, we would usually need to use two tags- A layer tag for NS 4 , and either a 

div or span tag for IE 4 

there is actually a way to create a "cross-browser" layer that uses only one tag, 

although its a little buggy on the NS side. Apparently NS 4 treats an absolutely 

positioned div the same as a layer 

<di v id="crosslayer" s tyle= "position:absolute ">< /div> 

Browser sniffing- object detection 

var ns4= 

101 



(navigator.appName=="Netscape"&&navigator.appVersion>=4) 

var ns4= (navigator . appName=="Microsoft Internet 

Explorer"&&navigator.appVersion>=4 ) 
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CONCLUSION 

ACHIVEMENTS 

• This project is develop to provide complete information of Punjab 
and Sindh. I tried a lot to provide complete information about these 
provinces. 

• One aspect that is very important in web sites is the human 
computer interaction . I have tried to ease out all the stuff related to 
the user and try to provide a GUI which user feels comfortable with 
and enjoy the site. 

• This site covered all important aspects relating to Punjab and Sindh 
.It is tried that all the important topics should be included. 
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USER GUIDE 

11 welcome To Geo-l'aklstan.tom . Microsoft InternE!t ~kplort!F!":~<"<>" . _ _. 

File Edit View Favorites " T~oIs . Help 

Welcome to GEO·PAKISTAN.COl\ll 
This web site has been designed to provide you with infonnation related 

to provinces ofPalcistan through the Internet. 

GEO PAKISTAN 

CLICK HERE TO ENTER 

PE Done _ _ _ . 
• Start 1\ f @ ~ rj-~ m- '- ,.1 il~,-'~~;'.~ U~ ~~~:-~~~7 

1. Click for the main window of the site 

113 



Pakistan has been the cradle of one of the oldest civilizations of the world The ruins ofHarappa show an 
advanced urban culture that flourished over 5000 years ago. Taxila. another historic landmark also stands 
out as a proof of the achievements of the area in learning. arts and crafts in bygone ages. Pakistan 
em.exged as a soverelgtl independent nation on August 14th 1947 after ahnost 200 years of British 

colonial rule. 

Because of its strategic location in the Indian sub-continent. wave after wave of migrants poured into the 
area and settled on its tertUe lands and today, although ongin.a1Iy belonging to the Aryan stock. the people 
of Pakistan are descendants of the Iranians, Turks, Afghans, and Arabs. The people of Pakistan 
ethnically belong to a pluralistic pattern of life. But they have a common idenl:rty: They have one common 
fai1h - Islam - and they proudly share its glorious tradilions m their lilougbt and conduct. m their reli,gious 
seIlS1bility, in folldore, in regional and domestic culture, and in their hopes and aspirations for the future. 

1'ht: dial~r.t.~ snokt:tt' ciiflnr. rp. on~ of. th~ land hav~ a common mnt and a h;!red h~~ Thr. r Ir ,. Loca!ntr_t 

»IJ ~Documentl - Microsoft w ... I@JWEL[OME TO PAKISTA._ 

2. Click menu for the site of great Pakistan 
3. Main window displaying various information . 
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File Edt View Favort es Tools Help 

-;to. 1;" [$j- Gj 1]fsearch ~FavOriteS 

e River Indus and its five tributaries flow through the lush green plains of the Punjab, givingth 
revince its name (the word Punj means five, ab means water). The Punjab IS the mos 
opulous proVInce and the most productive agricultural region of the country. Verdant fields an 
ast orchards produce bumper harvests of staple foods such as rice, wheat, cotton, fruits an 
egetables. Punjabis are a hardy race, strong on tradition and dignity. Many of the sons of thi 
oil sarve the nation as brave and devoted soldiers in the armed forces. Lahore. the pJovinci 
apital, retains the strongest impression of the grandeur of the Mughal era. The famous Mugha 
mperors loved this city and bequeathed to It a magnificent architectural legacy in mosques 
ausoleums and stately gardens. These monuments of the past are well-preserved as popula 

ourist attractions. Lahore is also the cultural centre of Paf.dstan and continues to provide th 
ation WIth emment philosophers, poets, wnters and sportsmen. Gifted craftsmen creat 
aditional handicrafts with a sf.dU and inspiration that is passed on from generations. Centurie 

--"-_~r-'f tradltion are intelWOVen in lJIe intricate des;qns of the famous carpets and dumes of lahore 
,.---~ 

, ~M\'~ 

.. I J ~U5ER GLn ... U~Poojab -._ The River ... 1 .....\I Punjab I ~TheRiver .. ·101- B:40 AM 

4.Click for main window. 
5.Click these links for further details. 
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File Edt View Favortes Tools Help 

~ Back ~ @:j GI ,a5eMch [±.JFavorltes MedIa '~ I ~~~ ..:J 
Mhss I@J D :\prOject\pr~vin~e~\Punj~b\PUNJAB ,HTM ~ 

CITIES OF PUNJAB I-Selectcny- il 

Punjab is Pakistan's most ferti le province, rich in both agriculture and ancient history. It's also 
one of the more stable of the country's regions, and travelers should have few of the problems 
that are faced further south and in the north . The prosperous and hospitable town of 
Bahaw alpur is a gentle introduction to the area. From here you can journey into Cholistan­
a sandy wasteland dotted with nomadic communities and wind-swept forts - or the Lal 
Suhanra NationaJ Park, an important wildlife reserve~. Further north is Harappa which is, 
after Mohenjodaro, the second most important site of the Indus Valley civilisation.Rawalpindi 
and the country's capital, Islamabad, are l.\iVin cities. The former is a patchwork of bustling 
bazaars wllile the latter is subdued, suburban and sti ll bei ng built (construction of the new 
capital di dn't begin unti I 1961). From here you can visit Tuila, an archaeological repository, 
and Hasan Abdul, a place of holy pilgrimmage.Bahawalpur is the most southerly town in the 
Punjab. There are daily flights from Islamabad about 555km (344mi) ffWay. Most of the major 
destinations in the Punjab can be reached by bus, minibus, and train. ' 

I " 

- ---f - ,- I~ My Compt7ter-- -

Start III riI '.oJ ~ I t::l nl i Ii[lUSER GUI .. , il iflpunjab - ,- The River .. ,l ~Punjab I i!jThe River .. , I rO~~i-8:52 ;;-

6,Click for cities of Punjab, 
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Rle EdJ1 

1 ~'~CJ.1U has it that Lahore was founded by two sons 'OfRama about 4,000 years ago. Histoncally ,it has 
' hr.r.vi,ipli that Lahore is about 2,000 years old Hieun-tsang. the famous Chinese pilgrim has given a vivid 
:,tie:scriob.<>n 'Of Lahore city which he visIted in the early parts of the sei'euth centlll'y AD. From 200 years, 
I be,~nn.g from about 1525AD Lahore was a thriving cultural center of the great Mughal Empire. Mughal 
IbU1Pe:lrors beautified Lahore with palaces, gardens and mosques. During the British regime, many monuments 

up in Lahore which blended beautifully with the Mughal, Gothic and VlCtorian styles of architecture. 
is the largest city of Pakistan and the provincial capital of Punjab. Apart from being the cultural and 

aCctde:rm'c center 'Of the countly, Lahore is the Mughal wShow Wmdow· of Palastan. The people of Lahore, 
1hey want to empha..<:ize 1he uniqueness of their town say ~ahore is Lahore". The traditional capital of 

for a thousand years, it had been the cultural center of North em India extending from Peshawar 
Delhi. This preeminent position it holds m Pakistan as wen. Lahore is the C1ty 'Of poets, artists and 1he 
offilm mdustry. It has the largest nllnlber of educational institutions in the country and s'Ome 'Of the finest 

in the c onl:!nent. 
I ....... ~.'" & Figures 

Distance from Capital: 2SS Km 
P- .. ' n: 6.212 million l1 ) 

I r g My Computer 

»IJ @]USERGur. .. I@jpunjab-._ . The River ,,, j --.!IPunjab l tjTheRlver", IIO--£I"')':1 8:55AM 

7.mainwindow of Lahore capital of Punjab. 
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) Done 

View Favorites Tools Help 

cademic center of the country, Lahore is the Mugha1 "Show Wmdow" of Pakistan. The people of Lahore, 
hen they want to emphasIZe the uniqueness "Of their town say "Lahore is Lahore" The traditional capital of 
~ab for a thousand years, it had been the cultural center ofNortb.em India extending from Peshawar to 

ew Delhi This preeminent position it holds in Pakistan as we[ Lahore is the city of poets, artists and the 
enter offilm industry It has the largest number ofeducalional institutions in the country and some of the finest 

gardens in the continent. 

acts & Figures 

Distance from Capital: 2S8 Km 
Population: 6.212 million (1998) 

Area: 500 Km2 
Climate: Wann in Summers and Cold in Winters 

Language: Urdu, English, Punjabi 

istorical ~aces 

~ ----- - -- -r r T- g MYCO~uter 
. !it t II 1 ~ 11 .:. 1"'-°, ' , r'!'I 
I; Bl'I IJ .:!:.I (oV ....",., ~ »1] ~U5ER uI,,·II IDPunjab- ... he River". , -IIPunjab i .fDTheRiver,,· IIO~~~ 8:57AM 

8 

a.C lick for further links of Lahore 
9. Click for main window of Punjab. 

9 
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TO.UROFTHE lYE 

Fie Edit VIeW Favorites Tools He~ --------
lfl ~ I ~5earch rlJ F~vorites 

Paklstan has been the cradle of one of the oldest civilizations of the world. The rums ofHarappa show an 
advancpcl urban culture tbatfl.Qurished over 5000 years ago. Taxila. anotherhisroric landmatk also stands 

1;1 roof of the achicvc~~ .;of the .rea i:l1ea:' "'e; 2...~ ~d crafts m byg""~e agec-. Pa..1ri..ct2-'l 
emerged as a sovereign mdependent nation on August 14th 1947 after almost 200 years of British 
colonial rcl . 

Because of its strategic location in the Indian sub-comment, wave aftu wave of migrants poured mto the 
area and settled on its fertile lands and today, although originaDy belongmg to the .Aryan stock, the people 
of Pakistan are descendants of the Iranians, Turks, Afghans, and Arabs. The people of Pakistan 
ethnically belong to a pluralistic pattern of life. But they have a common identity. They have one common 
faith - Islam - and they proUdly share .its glorious tradilioDS in theiI: tho. and conduct, in their religious 
sensibility, in folklore, in regional and domestic culture, and in their hopes and aspirations for the future. 

Th~ dial~r.tl; oSmokl'tn In drlf~~nt Tp.t>ioru: of. th~ hind havp. a .ommon 5c:rint lind a 5harl'!d hl'!niapp. I'll ,rr g My Computer 

12 

»IJ r®Joocum .. ·II4!JwELc... ~The Ri ... ' '-liPunjab I ~The Ri .. . ' I0qln~.--9~03 AM-
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I,g) Done 

!!J Favorites 

0:]1)1, Y I (' (1)1 C' 7 ~')' 
OFFICIAL NAME: I s l ~rnic Hllpublic or Pakistan. 

LOCATION: Latitude 24 anI137N. 
ongltutoe 62 and 75E. 

STATE RELIGION : 1~lllm. ARFA: 003.940 '><11101 

BOUNDARIES: iVghanistflfl Z.430 kill. Chin'l 523 kin. India 7.,917. km 

CLIMATE: Mostly hot. dry desert; t'.!llIpel<lte in IlQrthwp.5t M(.tic in nortll 

NATIONAL LANGUAGE: URDU 

MONETARY UNIT: Paklsl~n Rupee. 

NATIONAL DRESS: Shnlwllr f(:mme;z:. 

NATIONAL FLOWER: JnsOlin~. 

I 
j. st~lj illJ _ t:$lI ~I~ rlJ nil ~Docum .. ·II~wEL[' .. The Ri ... j .-!lpunjab I ~The Ri ... 1 

9 My Computer 

r 0.,£1- '1. 9:03 AM 
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I ~ ile Edit 

, <l-'Back T 

View Favorites Tools Help 

1/ !1J d:! I '@Search 
.-

l±J Favorites T I~ 1~ 1B. 
Address I~ D:\prOject\DEFAULT2. HTr'1===-=====""-======-"=~======-=====~" 

In the early days of independence it was felt thata new and permanent Capital City had to 
b8 bUIlt to r-afiect' e culillres. tradition£,liopes, aspirations and dreams 'of all dl rerse eth'cs. 
linguisnc and regional groups that constituted the Pakistam nation It was considered 
prudent and In the nationallnterBst to locate the F'ederal Capital Vv'here It could be isolated 
from tile onslaught of Dusiness and commercial interests and yet be easily accessible from 
even the remotest corner of the country In view of the Islamic ideology of the country the 
Federal Capital had be located closer to the Muslim areas of Central Asia and in close 
prc)ti'mlt:{ :(!f the fratema~ people of iran. Afghanistan, Sa'm ArabIa and TUrk6~i . 
comm!SSJon was accordingly constituted in 1958 and entrustM W1tri the task of selecting a 
sl\ltablE: site for the \Iatlonal Capitai With particular emphasIs on locatIOn, climate, logistiC, 
defense reqUirements. aesHletlc. scenic and natural beauty After the extensive research. 
feasibility stuaies and thorough re'v1eW of vanous sites. tne commiSSion recommended the 
area Northeast of Rawalpmdl. After the final deciSion of Cabinet the die was cast and there 
was no turning DOlnt A Greek timl Oio)1de~ A_S0clates drew up a master plan triElngulann 
sha'1e, based on a god system Wlth Its op8n towards the ivli::lrgalla HIlS The pi3I'1Tler s 
~ 'I'"'flg'" 1~IClmal ad A·".,rii'Ui"llly ut. . mg ~ JIN lip' tii entire'y 'lJ .Jtretc;hmg 1j all .0 the 

lfUl,i-. k'Cl I ~a" tit:: teG In (.t:ll expernse f [Ilox:aes and C1)ur-~ the 
u:atJon anc hard work of Pakistar. en tneer rech ieans andwork3;:;', "ch had ,u,.,e.d 

I I I ~ My Computer 

'The Ri ... j --",Punjab I .tJThe Ri .. . , I O~lc ~':1 9:01 AfVl 

121 



File Edit View Favorites Tools Help 
-_.- ----- -- - - - ------

{..J Back T -+ ft [f] f:ri4l 1 f!,\Search W Favorites .J'Media " lib T @ lQl T J~ ~ :B. 
Address I~ D:\Project\DEFAULT2.HTM 

QUAID-E-AZAM 

llAJlL Y LIFl! EAllL Y Df POLI'11CS CIll!AtOJl 01' NADON QUAID'S LAn MESSACE CHATOJI. OF J1J!BJ If A DON 

1 

-r --- -
.~ Done --I 
l;jQStart II ] c£I ~J ::-:J! rll »iJ '~Docum .. ·lliUwELc... - The Ri ... j . -.JIPunjab I @JThe Ri .. . j 
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File Edit View Favorites Tools Help 

,p Back • [.:fI Q1 1 ~Search (±J Favorites ~Media @ I ~. ~ ~ • J~ ~!,'! ;g 
Add~~ ~ D:\Project\provinces\Punjab\PUNJAB.HTI" 

he River Indus and its five tributaries flow through the lush green plarns of the Punjab, giving th 
province its name (the word Punj means five, ab means water). The Punjab is the mo 
[populous province and the most productive agricultural region of the country. Verdant fields an 
\fast orchards produce bumper harvests of staple foods such as nee. wheat. cotton. fruits an 
!vegetables Punjabis are a hardy race. strong on tradition and dignity. Many of the sons of thi 
soil serve the natkm as brave and devoted soldiers in the armed forces. Lahore, the provincia 
capital. retains the strongest impression of the grandeur of1he Mughal era The famous Mugha 
emperors loved this city and bequeathed to it a magnificent architectural legacy in mosques 
mausoleums and stately gardens. These monuments of the past are well-preserved as popula 
ourist attractions. Lahore is also the cultural centre of Pakistan and continues to provide the 
ation with eminent philosophers, poets, writers and sportsmen. Gifted craftsmen creat 
aditional handicrafts with a skill and inspiration that is passed on from generations. Centurie 

~~Jo.f tradition are interwoven in the intricate desl.Qns of ihe famous carpets and dumas of Lahore 
'-Done --------- - ----- - ---- --r-;-· ~MyC~----

~a5tart ll ' ril ~' L!iJ Iii [D )):J t:IDDocum· .. II~punja ... . TheRi .. ·1 -.JPunjab I ® TheRi .. ·1 : 0.,,£· 'l'" 9:06 Ar~ 

123 



File Edit View Favorites Tools Help 
- --------.,-

t-> Dad' ~ ... ~ ~ [1j r.;;'} I @ Search !±JFavorites (~Media f~ l ib? ~ [jj ? J~ ""5:'] !B. 
~~ddre~J~ D:\Project\LAHORE\indexlahore,htm . __ . __ 

egend has it that Lahore was fowded by two sons of RaIna about 4,000 years ago Historically ,it has been provided 1hat 
ahore is about 2,000 years old. Hieun-tsang, the famous Chinese pilgrim has given a vivid description of Lahore city which he 
.. d in the early parts of the seventh cemury AD. From 200 years, beginning fr~m about 1525AD .Lahore was a thriving 
ulb.:ral center of the great Mughal Empire. Mughal Emperors beaubfied Lahore with palaces, gardens and mosques. DW'ing the 

British regime, many monuments sprang up in Lahore which blended beantifully with the Mugbal, Gothic and VlCtonan styles of 
architecture. Lahore is the largest city of Pakistan and the provinc1al capital of Punjab. Apart from being the cultural and 

cademic center of the country, Lahore is the Mugba1"Show Wmdow" ofPalcistan. The people of Lahore, when they wantto 
hasize the uniqueness of their town say "Lahore is Lahore". The traditional capital of Punjab for a thousand years, it had been 
cultural center ofNOI1hem India extending from Peshawar to New Delhi. This preeminent position it holds in Pakistan as wen. 

Lahore is the city of poets, arUsts and the center of film industry. It has the largest number of educationai lnstitutions in the country 
and some of the finest gardens in the continent 

acts & Figures 

I"":') Done 

!rjQ5ta rt III riI j. 

Distance from Capital: 288 Km 
Population: 6.212 million (1998) 

Area: 500 Km2 
Climate: Warm in Summers and Cold In Winters 

Language: Urdu, English, Punjabi 

. r - I g My Computer - -­

nl j ~Docum · ,, 1 ~punjabo,, 1 4iPhe Rio" I --.!lLAHORE I ~The Rio" I ~legen... rO~I "1 9:07 AM 
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l File Edit View - Favorites Tools Help 

,~Back T .... ..J [11 ~ I ~5-ea-rc-h-(±j-F-a-vo-r it-es-~-· Media {~I ~T .J IQI T l!:J ~ !B. 
Addres;I~_D:\_pr_OJe:t\_pr_ov_lnceS\~lnd_h\_IN_DE_X.HTM 

I H 
IDee august 1947, Sindh is a province of Pakistan and has a historie region of the Pak-Hinj 
ubcontinenl It is essentially the Delta Country and has derived its name from its lif; 

eam, the river Indus, known to the people by the name of "Sindhu" from tim 
emorial. Sindh is bOWlded on the west by the province of Baluchistan, on the north b 

e province of Punjab, on the east and southeast by In~ and on the south and southwes 
y the Arabian sea. Its chief cities are: Karachi, the capital, and the largest city ofPakist 
yderabad, Sukkur, :Mirpurkhas, Lmkana & Nawab shah. Sindh province has an area 0 

58,471 square miles (151,440 sq. kID) and its population in 1992 was estimated to b 
9.991.In general Sindh corresponds to the lower Indus river valley, stretching from north t 
outh in the fonn of letter'S' , physiographic ally, Sindh can be divided into the west 
'gh1ands of the Khirthar Range and Kohistan area, rising to more than 6000 feet (1,83 
.) ; the central valley, with the eastern and western valley regions; and the delta region; an 
e Thar desert in the cast The climate is of the subtropical desen type with scanty rain ~ 

~"A"""" .;; ; ... n ...... - '1 ').;; m-\ .... ~.1-.. A - ;., a,~ ---~ _t"n~l.:~~ ~- c- -0-·-15' pr~..I"mm· - d. , 
U. .l.U&"W'" ,au.",,,,,,,,,,, ............ u..s..a}~""U&.1 • .&..&. :a.u.....u"V ;1. ..... .31.. u.s..L an..t~"aLJ.) LoU ... ",..u. IUY ~\,iUv 1 &..I)l '~ 

, I me tural an wends almost en' elv 0 irriRa' on. The Drin . a1 o'C f w r' s ~ 
I'~ Done----·--- r-1-r- !g My C;;mputer -- ---

l!l1start ll J r:a 1! ~J ~ ~ al »!] ®JDO(Um .. · II~ sindhc ... . TheRi .. . j -->lPunjab l':t:JTheRi .. . j I O~l l , 9:05AM 
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r~ Done -

CITIES OF SINDH f-SeledCily-

Sindh, of which Karachi is. the capital, stretches north on either side of the River Indus. Its b orders touch the 
aluchistan desert on the one 'side and Thar Desert with India on the other. The northern part ofthe Province 

abuts on Punjab while its southeast flank ends in the salt marshes of the Rann of Kutch. It has a short coastline 
lVashed by the Arabian Sea It takes its name from the Indus. known locally as Sindh - Indus is also the main 
artery of Pakistan and the life-stream of the lower valley, The name Sindh comes from the Sanskrit word 
Sindhu that means the divider describing the River Indus which divides the province into two , Sindhu was 
eventually abbreviated into Sindh. Sindh due to its unique geographic position, has remained an entity with its 
own historical parameters . Early history opens up when Darius I sent an army (515-500 BC) and Sindh was 
annexed by the Persian Empire, Nearly two centuries later, Sindh was stormed by Alexander the Great. whose 

arch has been fully conjectured on, by modem researchers, as is the case with other aspects of Sindh's 
'story, The broad feature of Alexander's conquest is that he saw a hostile country and encountered tough 

opposition. The foundation ofthe still existing town of Sehwan (sijistan) is attributed to Alexander, 
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